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2 CHAPTER 1. INTRODUCING SOT OFFICE

1.1 All about SOT Office

SOT Office is SOT’s suite of office programs and tools. You’ll find it
invaluable for any number of everyday tasks, from writing reports to
creating professional presentations. SOT Office contains the follow-
ing components:

• SOT Office Writer, a fully-featured word processor. SOT Of-
fice writer allows you create professional-looking documents—
letters, reports, web pages and more. It’ll even check your
spelling!

• SOT Office Impress, used to create professional presentations.

• SOT Office Calc, a sophisticated spreadsheet program. SOT Of-
fice Calc has all the tools you need to analyze data.

• SOT Office Draw, the graphical component of SOT Office. Use
SOT Office Draw to create diagrams, textures and other visual
effects

1.2 What you’ll find in this book

In the next chapters of this manual, you’ll find all the information
you need help make SOT Office an effective workplace tool.

Chapter 2, Installing SOT Office, guides you through setting up SOT
Office to work on your own computer, whether a standalone PC or a
networked desktop.

Chapter 3, Working with SOT Office, provides basic instruction in
using office software for beginners. This chapter begins with an ex-
plaination of the SOT Office toolbars, and how to enter, edit and for-
mat text. It continues by describing the specific techniques and tools
used to create each type of SOT Office document.

Chapter 4, SOT Office General Help, describes operations relevant
to all document types such as saving files, copying data between doc-
uments and customizing SOT Office to your needs.

Chapter 5, Macros in SOT Office, discusses how to install and use
macro functions to make work faster and more convenient.
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Finally, a list of handy keyboard shortcuts is presented in Appendix A.

1.3 SOT Office on the Web

Join SOT’s Community Network at http://www.sotlinux.org! Register
for free and discuss SOT Office in the user forums, where learners
and experts alike can share their experiences of using SOT Office.
We’d like to hear your opinions and ideas there too!

SOT Office has been thoroughly tested to ensure it works to our
high standards, but if you think you’ve found a bug that slipped
past us please report your experiences to our bug-tracking system at
bugzilla.sotlinux.org.
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6 CHAPTER 2. INSTALLING SOT OFFICE

2.1 Single and Multi-user installation

SOT Office can be installed in one of two ways:

Single-User Installation This installation method is used to install
SOT Office for a single user only. The advantage of this method
is that you don’t need to have administrative access to install the
program—SOT Office can be set up to run from a single user’s
local directory. However, this method is not recommended for
systems with more than one user as each would have to install
a separate copy.

Multi-user/Network Installation This method is appropriate for sys-
tems with multiple user accounts. In the first phase of a Multi-
User/Network Installation all shared SOT Office components are
installed. In the second phase, Workstation Installation, 2 to 4
MB of user-specific files are installed for each user who wishes
to run SOT Office.

2.2 Installing under Windows

2.2.1 System Requirements

SOT Office can be installed on the Windows 95, 98, NT(sp3), 2000
and XP platforms. The installation process will require approximately
235 MB of free disk space, although the progam itself will only take
up 120 MB once installation is complete.

Note to Windows 95 users: Windows 95 requires additional run-
time libraries to successfully run SOT Office. Before attempting to
install SOT Office, you should download and install the following
from the Microsoft website:

• DCOM95 for Windows 95, available from
http://www.microsoft.com/com/dcom/dcom95/dcom1 3.asp

• MSVCRT run-time library, available from
ftp://ftp.microsoft.com/softlib/mslfiles/msvcrt.exe
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2.2.2 Starting the installation

To begin the installation of SOT Office, follow these steps:

1. Close down any running Windows programs, and open the
windows \soto en\setup.exe file from the SOT Office installa-
tion CD. The set-up files will be unpacked into a temporary di-
rectory, and in a moment installation will begin.

2. Read the License Agreement that appears. Continuing with the
installation indicates you agree with the terms of the license.

3. Complete the ”User Data” form. This information will be used
in your document templates, for example to automatically con-
struct a return address in letters you write.

4. Select an installation type. The Standard installation provides
you with the full range of SOT Office applications, and requires
approximately 120 MB or disk space. The Minimal installation
includes only the most important applications, and requires 103
MB. Alternatively, you may select indivual application to install
by choosing the Custom option.

5. Select an installation folder for the SOT Office software. In most
cases the recommended default is sufficent.

6. The installer will attempt to locate a Java runtime environment
on your computer. SOT Writer uses the Java environment to
display certain web-pages that make use of Java and Javascript.
If you don’t have Java installed, or are unsure, you may install
SOT Office without Java support. You won’t be able to view
the aforementioned web-pages in SOT Writer, but otherwise the
absence of a Java environment will make no difference to your
SOT Office experience.

7. The application files will be copied to your hard drive. Please be
patient, as this may require several minutes.

8. You may choose to import contact lists/address books from sev-
eral major email applications or other databases. Doing so will
make a copy of your current list of contacts available to SOT
Office.
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9. Complete the installation.

A shortcut to the SOT Office software will be created in your Start
menu. Use this link, under PROGRAMS>SOT OFFICE to start the SOT
Office application.

2.2.3 Uninstalling SOT Office under Windows

SOT Office may be removed via the ”ADD/REMOVE PROGRAMS” wiz-
ard, located in the Control Panel.

2.3 Installing under GNU/Linux using RPM

RPM technology provides a convenient method of installing, updating
and removing software packages. SOT Office may be installed using
the GNU/Linux rpm command, or by using a graphical RPM program
like kpackage . Below we describe how to install SOT Office from the
command line.

Installing SOT Office using RPM effectively provides a Multi-User/Network
installation. If you wish to install SOT Office in Single-User mode, see
Installing under GNU/Linux using a script, below.

2.3.1 System requirements

To install the SOT Office RPM your GNU/Linux system requires:

• glibc version 2.2.1 or higher

• XFree86 version 4.1.0 or higher

• rpm version 3.0.5 or higher

• Approximately 265 MB of free space on your hard drive.
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2.3.2 Starting the installation

NB If you already have a previous version of SOT Office
installed you must uninstall it first or the setup program
will refuse to run. Alternatively you may consider updating
your existing installation with the latest BOHF instead of
installing a new version of SOT Office from scratch.

To install the SOT Office RPM do the following:

1. Load your SOT Office installation CD and mount it using the
command
mount /mnt/cdrom

2. Install the SOT Office package with the command:
rpm -vih /mnt/cdrom/Linux/RPM/soto-2003R1en.i386.rpm

Installing the RPM provides the shared components of a Multi-
User Installation (phase 1). After the RPM is installed, each
user who wishes to use SOT Office must log in to the system
and perform a quick Workstation Installation (phase 2), as de-
scribed in the next step. Note that SOT Office cannot be run
(even by root) until the user-specific Workstation Installation
step is completed.

3. To perform the user-specific Workstation installation phase for
each user, log in as a user who wishes to install SOT Office.
Click on any SOT Office link from the K-menu (e.g. Work >Office
> Writer), or alternatively run the command
/usr/bin/SOTOffice.sh from the command line. This will be-
gin installation of the user-specific SOT Office files.

4. Read the License Agreement that appears. Continuing with the
installation indicates you agree with the terms of the license.

5. Complete the ”User Data” form. This information will be used
in your document templates, for example to automatically con-
struct a return address in letters you write.

6. Select an installation type. The Workstation Installation will in-
stall only the current user’s required configuration files, and
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needs 2 to 4 MB of free disk space. Choosing the Local Installa-
tion option will install a complete, independent version of SOT
Office in a local directory.

7. Select an installation folder for the SOT Office software. If you
do not wish to use the default path, you may select your own
path by clicking on the ”Browse: button.

8. The installer will attempt to locate a Java runtime environment
on your computer. SOT Writer uses the Java environment to
display certain web-pages that make use of Java and Javascript.
If you don’t have Java installed, or are unsure, you may install
SOT Office without Java support. You won’t be able to view
the aforementioned web-pages in SOT Writer, but otherwise the
absence of a Java environment will make no difference to your
SOT Office experience.

9. The application files will be copied to your hard drive. Please be
patient, as this may require several minutes.

10. Complete the installation.

To run the SOT Office application, click on the SOT Office icon on
your desktop, or issue from the command line:
/usr/bin/SOTOffice.sh

The first time you run SOT Office you may choose to import con-
tact lists/address books from several major email applications or
databases. Doing so will make a copy of your current list available to
the SOT Office program.

2.3.3 Uninstalling under GNU/Linux using RPM

To remove an RPM-installed SOT Office program, enter the following
at a command prompt:
rpm -e soto

To remove personalized settings from your home directory, enter:
rm -rf $HOME/SOTO

Lastly, remove the corresponding entry from the $HOME/.sversionrc
file.
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2.4 Installing under GNU/Linux using a script

If you are unable or do not wish to use the RPM package to install
SOT Office, you may instead use an install script.

2.4.1 System requirements

Installing SOT Office using a script requires your GNU/Linux system
to have:

• glibc version 2.2.1 or higher

• Approximately 365 MB of free space on your hard drive. The
actual size of the installation is 265 MB, but aproximately 100
additional MB of temporary space will be required during the
installation itself.

2.4.2 Starting the installation

To install SOT Office using a script, follow these steps:

1. Insert and mount your SOT Office installation CD by entering:
mount /mnt/cdrom at a command prompt.

2. Change your directory to the SOTO installation directory of the
CD-ROM by entering
cd /mnt/cdrom followed by
cd Linux/soto en

3. Enter
./setup for a Single-User installation or
./setup -net for a Multi-User/Network installation.

If you are performing a Multi-User/Network installation, the
shared SOT Office components will be installed automatically.
To continue with the second phase of the Multi-User/Network
installation, proceed with step 3 under Installing under GNU/Linux
using RPM, above. If you are performing a Single-User installa-
tion continue with the steps below.



12 CHAPTER 2. INSTALLING SOT OFFICE

4. Read the License Agreement that appears. Continuing with the
installation indicates you agree with the terms of the license.

5. Complete the ”User Data” form. This information will be used
in your document templates, for example to automatically con-
struct a return address in letters you write.

6. Select an installation type. The Standard installation provides
you with the full range of SOT Office applications, and requires
approximately 265 MB or disk space. The Minimal installation
includes only the most important applications, and requires 238
MB. Alternatively, you may select indivual application to install
by choosing the Custom option.

7. Select an installation folder for the SOT Office software. If you
do not wish to use the default path, you may select your own
path by clicking on the ”Browse: button.

8. The installer will attempt to locate a Java runtime environment
on your computer. SOT Writer uses the Java environment to
display certain web-pages that make use of Java and Javascript.
If you don’t have Java installed, or are unsure, you may install
SOT Office without Java support. You won’t be able to view
the aforementioned web-pages in SOT Writer, but otherwise the
absence of a Java environment will make no difference to your
SOT Office experience.

9. The application files will be copied to your hard drive. Please be
patient, as this may require several minutes.

10. You may choose to import contact lists/address books from sev-
eral major email applications or other databases. Doing so will
make a copy of your current list of contacts available to SOT
Office.

11. Complete the installation.

The SOT Office files will be installed by default into the ”soto” folder
in your home directory.
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3.1 Working with SOT Office

3.1.1 Getting started with SOT Office

If you’re using Windows, you’ll find SOT Office from the Start Menu,
under PROGRAMS>SOT OFFICE.

To run SOT Office under GNU/Linux, click on the K-menu button
and go into the WORK>OFFICE sub-menu.

The individual SOT Office programs are located within the sub-menu.
Among others, you’ll see WRITING, SPREADSHEET, PRESENTATION and
DRAWING. Enter the appropriate sub-menu and click on the SOT
Office icon within.

When SOT Office has loaded, you’ll see a screen similar to Figure 3.1.

Figure 3.1: The SOT Office screen

Figure 3.1 depicts SOT Office Writer, but all the SOT Office programs
have a similar layout:

• A menu bar running along the top of the screen. The menu bar
contains all the functions you’ll need to properly create, format,
save and edit your documents. For your convenience, many of
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the functions from the menu bar are also represented as click-
able buttons on various toolbars.

• A function bar just below the menu bar. On the function bar
are buttons you can click to perform the most common tasks in
SOT Office—opening and saving files, cutting and pasting text
etc. To see what a button does, rest the mouse pointer over the
button without clicking. After a second or two, the name of the
button will appear.

If a button isn’t available (for example, the ”cut” button if you
haven’t selected any text) it will be grayed out.

For most buttons, a single click will perform the selected task:
clicking on the ”print” button will send your current document
to the printer for example.

Some icons feature a small green pointer, indicating that sev-
eral different options are available from a secondary menu. For
example the ”new” button: , can be used to start a new text
document, spreadsheet, presentation etc. When you click on
this kind of button, hold down the mouse button until the hid-
den menu appears, then make your selection. This process is
called ”long-clicking”.

• An object bar directly below the function bar. The object bar
contains text-formatting functions: you can use the buttons
here to change the style, size, color and alignment of your text.

• The main toolbar, placed vertically down the left of the screen
hosts a number of other useful buttons used to: search for text,
insert objects into your documents, and check your spelling.

3.1.2 Saving your work

To save your document to disk, click on the save icon or choose
FILE>SAVE from the menu bar. A dialog box will appear where you
can choose the name you’ll give to your saved file. You may also
choose to save the file as one of several file types. The default file
type, SOT Office, ensures that the document will be saved exactly as
you designed it, although it will only be able to be opened by SOT
Office or a compatible office program. Alternatively, you can save



16 CHAPTER 3. WORKING WITH SOT OFFICE

your file in Microsoft format to allow it to be opened by Microsoft
office software. Saving your file as plain ”Text” allows it to be read by
any computer, but you will lose any special formatting.

3.2 Creating a document with SOT Office
Writer

3.2.1 Entering and editing text

When you begin a new SOT Office text document you’ll be confronted
with a blank page. Just start typing! Your text will appear on the
screen at the point where you see the flashing cursor. If you need
to edit earlier (or later) sections of the text you can move the cursor
using the arrow keys on your keyboard. The left and right arrow
keys will move the cursor one character back or forward at a time,
while the up and down arrows will move the cursor one line at a
time. Alternatively, you can use the mouse and just click at the point
to where you’d like to move the cursor. Moving the cursor by these
methods will not delete any of your text.

For larger documents, the PAGE UP and PAGE DOWN keys will scroll
through the text one screenful at a time, or dragging the scroll bar
at the right of the screen will have the same effect. Note that neither
of these methods will actually move the cursor, so when you find the
section of the document you’re looking for click once with the mouse
to reposition the cursor.

3.2.2 Selecting text

To apply formatting to text, you’ll need to first select the text. Place
the cursor at the beginning of the text in question, hold down the left
mouse button and drag the cursor to the end of the text selection.
The selected text will appear highlighted. Any formatting functions
you then select from the Menu bar or toolbars will be applied to the
selected text.
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3.2.3 Deleting text

Use the BACKSPACE KEY to remove the character to the left of the
cursor, or the DELETE key to remove the character to the right of the
cursor. To delete larger chunks of text, select the text you want to
remove and press BACKSPACE.

3.2.4 Cutting, Copying and Pasting

To move a block of text to a different part of your document, use the
technique of ”cutting and pasting”. Select the text to be moved and

click on the cut button: , or use keyboard shortcut CTRL X. The
selected text will be removed from the document and saved to the
clipboard. To re-insert the text, position the cursor at the appropriate

point and click the paste button: (keyboard shortcut CTRL V).
The text in the clipboard will be inserted into your document. If you
simply want to copy a piece of text without removing it, use the copy

command: (CTRL C) instead of cut.

3.2.5 Formatting text

To create interesting effects, use SOT Office’s formatting functions
to change the appearance of your text. Any new text you type after
selecting a format will appear in the selected format. To change the
appearance of existing text, select the text to be changed, then choose
a format. The new format will be applied to the selected text.

• Change font. Click on the arrow in the ”Font Name” box on the
object bar ( ) to choose from a selection of typefaces. Text
can similarly be made to appear larger or smaller by choosing
an appropriate size from the ”Font Size” box:

• Emphasize text using the bold, italic and underline functions:

• Align text to appear left-, right- or center justified:

• Change the color of your text by holding down the mouse button

over the text color button ( ). This will bring up a palette of
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colors to choose from. You can also change the background

color to achieve a highlight effect:

You can perform more detailed text formatting using the FORMAT

menu from the menu bar. FORMAT>CHARACTER provides options
for changing the appearance of the typed letters themselves, while
FORMAT>PARAGRAPH lets you format the properties of larger blocks
of text, like spacing and text alignment.

3.2.6 Creating a document structure

To create professional-looking documents, SOT Office Writer allows
you to structure your text with section headings, tables of contents
and indices. These are accomplished through the use of styles.

Styles

To help arrange your document into a consistent structure, make
use of styles. Styles are collections of formatting properties (i.e. a
particular font shape, size, color, layout etc) used to identify different
sections of your document. For example, you’ll use a ”Header” style
with a large, bold font to create section titles and a smaller ”Text
body” style for ordinary paragraph text.

SOT Office comes with a number of predefined styles. Choose

FORMAT>STYLIST from the menu bar, or click the Stylist button to
bring up the Stylist window (Figure 3.2).

The five buttons at the top of the Stylist window are used to access
the different types of style:

• Paragraph styles are used to format entire paragraphs.

• Character styles change the appearance of smaller units of
text

• Frame styles change the appearance of the graphics included
in your document, for example printing watermarks or borders.
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Figure 3.2: The Stylist

• Page styles modify the structure of an individual page, for
example the appearance of headers and footers.

• Numbering styles can be used to customize the appearance
of numbering and bullets.

Creating section headings

Header styles can be found under ”paragraph styles” in the Stylist,
and come in several sizes. ”Heading 1” is the largest, used for main
section titles in the text. The smaller sizes can be used for sub-
headings. To create section headings in your document:

• Type in the text you’ll use as your heading and press ENTER.

• Position the cursor somewhere in the heading line you just typed
(it doesn’t matter exactly where).

• Double-click on the ”Header 1” entry in the Stylist.

Your text will be automatically formatted to conform with the chosen
style.
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If you don’t like the default font size, shape or color of SOT Office’s
headings you’re welcome to create your own custom heading styles.

To create custom Heading styles, click once on the Heading style you
want to edit in the Stylist. Next, open the context menu by clicking
the right-hand mouse button and select modify.

Figure 3.3: Editing a style

From the resultant window, you can modify all the properties of the
style.

Page numbering using Headers and Footers

To automatically print page numbers in your document you’ll need
to create either a Header or Footer, depending on whether you want
the numbering to appear at the top or bottom of your pages.

Headers and Footers are defined using page styles. The simplest way
to perform page numbering is to print the page numbers centered
at the top (or bottom) of the page. This only requires a single page
style. Slightly more complicated is to have the page numbers justified
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to the left or right depending on the page, as in a book for example.
This require two different page styles, one for ”left” pages and one for
”right” pages.

To insert a header (or footer) for simple page numbering into your
document, go to the INSERT menu and choose HEADER (or FOOTER).
You’ll also need to select the page style in which the header/footer
appears. Select ALL to have the same header/footer appear on all
pages. This will create an empty header/footer in your document. Po-
sition the cursor inside the header/footer and select from the INSERT

menu FIELDS>PAGE NUMBERS. The number of your current page
will appear in the header/footer. You can center the page number by

clicking on the ”Centered” alignment button in the object toolbar: .

To create separate left and right-hand page numbering, start with the
cursor in the text of a left-hand page and insert a header/footer from
the FORMAT menu. This time, select the page style as LEFT, and after
you insert the page number field, select the left-alignment button.
Reposition the cursor in a right-hand page and repeat the process,
choosing RIGHT page style and right-alignment. Finally, you’ll need
to tell SOT Office to automatically apply the LEFT and RIGHT page
styles, one after the other. To do this:

• Open the Stylist using FORMAT>STYLIST from the menu bar, or

clicking on the Stylist button .

• Click the ”page” styles button in the Stylist:

• Single-click on the ”Left Page” entry, then right-click to bring up
the context menu and choose ”Modify”

• In the Style window that appears, click on the ”Organizer” tab
and set ”Right Page” as the Next Style. This tells SOT Office to
apply the Right Page style to the page following a Left Page style.

• Do the reverse for the ”Right Page” style, setting its Next Page
style to ”Left Page”.

Creating a Table of Contents

Creating a table of contents is easy, as long as you’ve applied ”Head-
ing” styles to the section headings throughout your document. Po-
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sition the cursor where you want to place the Table of Contents and
select INDEXES AND TABLES>INDEXES AND TABLES from the INSERT

menu. In the window that appears, choose ”Table of Contents” as the
Index/Table Type. You can also specify how many levels will appear
in the table of contents. To list only major sections (i.e. those with
a style of Heading 1), set the ”Evaluate up to level” value to 1. In-
creasing this number will also include subsection headings (Heading
2), subsubsections (Heading 3) etc. in the contents.

Creating an Index

To create a keyword index, you first need to choose which of your
document’s words will be listed in the index:

• Click on a word you want to list in the index.

• Select from the INSERT menu INDEXES AND TABLES>ENTRY.

• A window will appear allowing you to specify how the word will
appear in the index. The ENTRY field contains the name of the
word you’ve selected. You may edit how this word appears in
the index. You may wish to do this to create cross-references.
For example, if the word you’ve chosen is ”iron”, you can edit
the word to have it appear in the index as ”iron, see also met-
als”. The 1ST KEY and 2ND KEY fields let you specify multi-level
entries. If, for example, your selected word is ”iron”, and your
enter ”Exports” as the 1st key, the entry will appear in the index
under ”E” as ”Exports, iron”.

• Press the INSERT button to add the entry to the index.

• Press CLOSE to return to your document.

After you’ve added your entries to the index you’re ready to insert the
alphabetized list in your document. From the INSERT menu, choose
INDEXES AND TABLES>INDEXES AND TABLES and select ”Alphabetical
Index” as the Index/Table type.
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3.2.7 Checking your spelling

Checking your spelling with SOT Office Writer is simple. For contin-
uous spell-checking, turn on the Auto Spellcheck function from its

icon on the main toolbar ( ) or from the menu
TOOLS>SPELLCHECK>AUTOSPELLCHECK. Any words not in SOT Of-
fice’s dictionary will be underlined in red on the screen.

To take a closer look at your spelling, you can perform a ”classic”

spellcheck using the Spellcheck button ( ) or
TOOLS>SPELLCHECK>CHECK. SOT Office will display each unrecog-
nized word in a window where you can correct the spelling yourself,
or choose from a number of suggested corrections.

3.3 Using a spreadsheet with SOT Office Calc

3.3.1 The spreadsheet at first glance

When you start SOT Office Calc you’ll first see a blank spreadsheet—
a page filled with empty cells. Each cell in the spread has a unique
address. If you look at the left-hand side of the spreadsheet you’ll see
that the cells are arranged in numbered rows down the page: 1, 2,
3, etc. Looking that the top of the sheet you can also see that they
are organized into columns marching across the page, each column
identified by a letter of the alphabet: A, B, C, etc.

3.3.2 Cells and Data

Cells

Cells are uniquely identified by stating their column and row (in that
order). For example, the cell at the upper left of the page is cell A1,
while the cell two spaces to the right and one row down is C2. A dark
border indicates the cell that is currently selected. You can select
different cells by pointing and clicking with the mouse, or by using
the arrow keys on your keyboard.



24 CHAPTER 3. WORKING WITH SOT OFFICE

Cell contents

If you select a cell by moving the mouse pointer over it and clicking,
you’ll find you can enter data into the cell. A cell can hold any text
you type, and will also recognize values: numbers, times and dates.

The data you enter into a cell also appears in the formula bar just
above the spreadsheet itself. You may find it easier to edit long texts
in the formula bar rather then in the cell itself.

After you’ve finished typing your data into a cell, press the ENTER key
to confirm the data and move to the cell below or TAB to confirm and
move to the next cell to the right.

Cell ranges

Individual cells are named by giving their column and row: A3, C6,
J21 etc. You can also refer to entire groups of cells at a time by
specifying a cell range. Cell ranges consist of the a rectangular block
of cells and are described by the address of the cell at the top left of
the range followed by a colon, then the address of the cell at the lower
right. For example, the 3 by 4 block of cells from B2 to D5 is written:
B2:D5.

3.3.3 Formulas

As well as text and numbers, cells can hold formulas. This is how
you can use SOT Office Calc to perform calculations.

Formulas always begin with the equality sign: =. For example, to add
the contents of cells B1 and B2, and place the result in cell B3, select
cell B3 and enter: =B1+B2. The resulting figure will appear in cell
B3. If you then change the values in cells B1 or B2, the sum in B3
will be updated automatically.

Formulas can contain any of the standard four arithmetic operators
+ (addition), - (subtraction), / (division) and * (multiplication). You
can also use parentheses () to specify the order in which operations
occur.

Instead of typing out the address of the cells in a formula, you can
simply point and click to indicate the desired cells. For example, the
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formula above could be entered by selecting cell B3, typing =, clicking
on cell B1, entering + then clicking on cell B2.

3.3.4 Functions

In addition to ordinary arithmetic, formulas can contain more ad-
vanced mathematical functions. To insert a function in cell, first
select the cell then choose INSERT>FUNCTION from the menu bar. A
window containing a list of functions appears.

Figure 3.4: Entering a function in SOT Office Calc

Using the ”Category” selector you may browse the list of all functions,
or narrow the list to functions in a particular category (Financial,
Statistical etc.) Single-clicking on the name of a function brings up a
description of the function and its list of required arguments. Dou-
ble clicking revels an editor where you can enter the relevant values
into the function. The whole function description appears in a text
box at the bottom of the window. When you’ve finished editing your
function, pressing OK inserts the function into your spreadsheet.

Functions are written in the form
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=FUNCTION(argument1;argument2...), i.e. an equality sign, the name
of the function, followed by a list of arguments enclosed in parenthe-
ses and separated by semicolons. Arguments can be actual numbers:
2, 647, 34.5, or strings of text: ”Sales”, ”Smith”, but are usually the
addresses of other cells containing such values. For brevity, you can
specify ranges of cells instead of listing each cell individually. For ex-
ample, =SUM(C6:C20) will add up all the cells between C6 and C20
inclusive.

Some of the most common functions are listed below:

• SUM(number1;number2...). The SUM function simply adds to-
gether all the cells listed in its arguments.

• AVERAGE(number1;number2...). The AVERAGE functions re-
turns the statistical average of all the listed cells.

• CONVERT(value;currency1;currency2) converts the value from
the first currency to the second. For example, if cell B2 con-
tains a number representing a number of Finnish Marks, you
can display the equivalent number of Euros in cell C2 by click-
ing in C2 and entering =CONVERT(B2;”FIM”;”EUR”). The quota-
tion marks around the currency name are necessary—all textual
arguments must be enclosed in double quotes.

• MAX(number1;number2...) returns the largest value that oc-
curs in the list of arguments.

• TODAY() takes no arguments, and simply displays the current
date in the selected cell.

3.3.5 Formatting cells

You can change the appearance of data in cells using the buttons
on the object toolbar. The font name and font size selectors allow
you to change the typeface displayed in each cell and vary the size

of the text. The bold, italics and underline buttons let you
emphasize certain cells by changing the text style.

You can also determine how numbers are to be displayed. Selecting a
cell (or range or cells) and clicking on the five number format buttons
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will automatically re-format the cells to display numbers and values
in the following formats:

• Currency number format displays the cell values as units of
currency.

• Percent format shows all selected values as percentages, ap-
pending a % sign to the number.

• Standard number format removes any special number for-
matting.

• Add decimal format increases the number of decimal places
displayed on the screen.

• Remove decimal format decreases the number of decimal places
displayed. Note that the actual value in the cell remains un-
changed. For display purposes, and extra decimal places are
rounded.

For more specific formatting options for currencies, dates etc. click
on the menu item FORMAT>CELLS to bring up a window containing
all formatting options.

3.3.6 Automatic fill

SOT Office Calc’s automatic fill feature is the fastest way to enter
incremental lists and copy formulas into adjacent cells. To use au-
tomatic fill, first select the cell containing the data you wish to copy.
Then click and hold down the mouse button on the small ”handle”
the lower right-hand corner of the cell. Your pointer will change into
a cross (+). Still holding down the mouse button, drag the pointer
across into adjacent cells. When you release the mouse button, all
the selected cells will be filled with data extrapolated from the original
cell.

For example, if cell A1 contains the date ”January”, clicking on A1
and dragging the fill handle into A5 will cause cells A2 to A5 to be
filled with the dates ”February” to ”May”.
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Numbers are also extrapolated. If cell B3 contains the number 7,
dragging the fill handle to the right will cause cells C3, D3 and E3 to
have the values 8, 9, and 10 respectively.

The arguments of formulas are also offset when using automatic fill.
For example, imagine you have two columns of numbers in columns
A and B. You’d like to add these together and place the result in
column C. Starting in cell C1, you’d enter =A1+B1. Using automatic
fill to complete the rest of column C automatically increments the cell
addresses in your formula. If you drag the fill handle from C1 to C5
you’ll find the the copied formula appears in C5 as =A5+B5.

3.3.7 Creating charts

Charts are for most people a more accessible way to read the data in
a spreadsheet. To create a chart from a table of data, select the cells
containing the data (including headings) and select INSERT>CHART

from the menu bar. A window will appear containing information
about the chart. Follow the prompts to format your chart, clicking
the NEXT button to proceed to the next screen. You’ll be given the
opportunity to select the type of chart you want to create, from pie
charts to histograms and many other types. You’ll also be able to
create title for your chart, and a legend if required. When you’ve
complete all the information, click the CREATE button to insert the
chart into your spreadsheet.

3.4 Presentations with SOT Office Impress

3.4.1 Using Impress

SOT Office Impress can be used to create eye-catching presentations
in the form of slides or OHPs.

3.4.2 Creating a new presentation

When you begin a new presentation in SOT Office, the autopilot win-
dow will appear, asking whether you’d like to begin with an empty
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presentation or open a previously saved presentation. To create a
fresh document, select ”Empty presentation” and click on the NEXT

button.

A second window will appear, where you can select the medium in
which your presentation will be delivered: as OHP sheets, slides,
displayed on a computer or simply printed out on paper. Make you
selection and click the NEXT button to continue.

The third screen deals with transitions between the individual slides
of your presentation. Using the ”Effect” selector, you can choose
from a wide range of transition effects: cross-fades, dissolves and
more. The ”Speed” selector determines how long each transition ef-
fect lasts. You can also choose whether to automatically or manually
cycle through the slides here. Select the ”Default” presentation type
to manually advance slides. You’ll have to click the mouse when you
want to advance to the next slide. Otherwise, you can choose to have
the slides automatically displayed, one after the other. In this case,
select ”Automatic” and fill in the ”Duration of page” and ”Duration
of pause” boxes. ”Duration of page” refers to the length of time each
page is displayed before being replace by the next slide, while ”Du-
ration of pause” is the length of time the presentation pauses at the
end before it begins again.

Click CREATE to begin working on your first slide.

SOT Office Impress will automatically open a dialog box where you
can choose the layout of your first slide. Choose a slide corresponding
to the layout you wish to create, or select the ”Blank slide” layout to
create your own.

3.4.3 SOT Office Impress views

At the upper right of the SOT Office Impress screen are series of
buttons used to change the view of your current presentation:

• Drawing view. Use the drawing view when you’re at work
designing individual slides. In this view, you will be able to add
text and graphics to the foreground of your slide.

• Outline view. Use this view to create titles for each of the slides
in your presentation.
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Figure 3.5: Choosing a layout for your slide

• Slides view. This view shows your an overview of all the slides,
indicating the order of their appearance in the presentation. Us-
ing this view, you can rearrange the sequence of the slides.

• Notes view. Use this view to create notes to yourself about
each of the slides. The notes will not be displayed during the
presentation, but you can print them out to use as reminders
for yourself.

• Handout view. This view reduces the size of the slides to fit
several on a printed page. These pages might be useful as ma-
terial in your presentation, for example to distribute to the au-
dience.

• Start slide show. Clicking this button will begin the presenta-
tion of the slideshow.
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3.4.4 Choose a background for a slide

To create an interesting background for your slides, click on
FORMAT>PAGE from the menu bar. In the windows that appears,
select the ”Background” tab. Here can choose to fill the background
of your slide with:

• Color. A single block color.

• Gradient. A combination of two colors.

• Hatching. Simple geometric patters.

• Bitmaps. Photo-realistic effects such as gravel, flowers, bricks
etc.

Select the background you want and click OK. SOT Office Impress
will ask whether you want to apply your chosen background to be
applied to all the slides in your presentation, or just the current slide.

3.4.5 Adding text to a slide

If you’ve select a pre-designed layout for your slide, text boxes will
already be present on the page. Simply type whatever text you need

into them. To add a new text area to the page, use the text button
on the main toolbar to create new text box.

You can change the style of your text by selecting it, then apply-
ing font styles, sizes, color and emphasis (bold, italic and underline)
from the object toolbar. Using the FORMAT>TEXT selection from the
menu bar you can also create advanced effects like animated text
that scrolls across the screen.

3.4.6 Adding graphics to a slide

Using the drawing tools from the main toolbar you can add geometric
objects to your page such as rectangles and ellipses, as well as their
3-dimensional equivalents, boxes and spheres. You can also insert
arrows and connection line to create flow-charts etc. using these
tools.
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Figure 3.6: Drawing tools

3.4.7 Adding more slides

To add a second (or third, fourth...) slide to your presentation, choose
INSERT>SLIDE from the menu bar. You will be able to choose a new
layout for your new slide if you wish.

3.4.8 Presenting your slides

To view all the slides in your presentation, in the order in which they

will appear, click on the slide view button at the upper right of the
screen. To change the order of appearance, simply click on a slide
you want to move and drag the it to a new position in the sequence.

To play your presentation, click on the ”start slide show” button:

3.5 Creating graphics with SOT Office Draw

3.5.1 Getting started with Draw

Use SOT Office Draw to create diagrams and drawing using vector
graphics made up of lines, curves and other shapes.

To open a new drawing document, select NEW>DRAWING from the
FILE menu or from the NEW button on the toolbar.
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3.5.2 Drawing rectangles and ellipses

Squares and rectangles

Long-click on the rectangle button on the main toolbar: . The rect-
angle menu will open, offering several different types of rectangular
figure: rectangular or square with straight or rounded corners. Each
is offered as an unfilled shape, where only the edges are drawn, or
as a solid block. If you hold the pointer over an icon in the menu,
the name of the shape will appear. Click on the type of rectangle
you wish to draw. The rectangular icon in the main toolbar will be
replaced by the specific type of rectangle you’ve chosen. The pointer
will change to a cross-hair (+), indicating that you are now ready to
draw a rectangle on your page. After the rectangle has been draw the
cross-hair will revert to a regular pointer. If you intend to to draw a
number of similar rectangles, double-click on the rectangle icon on
the main toolbar. This will enable you to keep drawing rectangles
until you select a different function from the toolbar.

To place your rectangle on the page, click at a point on the page
where you want one corner of the rectangle to appear and hold down
the mouse button. Drag the pointer across the page and an outline of
your rectangle will appear with your pointer tracing out the opposite
corner of the rectangle. Keep dragging the mouse until your rectangle
has achieved the desired shape and size, then release the mouse
button. The rectangle will then appear on the page.

Circles and ellipses

Ellipses and circles (including fragments thereof) can be obtained

from the ellipse button: . Ellipses and circles can be drawn in
the same manner as rectangles.

An extra step in involved in drawing a ”circle pie” or ”ellipse segment”.
Click on the circle pie or ellipse segment icon from the ellipse sub-
menu. The pointer changes into a cross-hair and you can draw the
mouse on the page to draw out the shape. At this stage it will appear
as an ordinary circle or ellipse. When the ellipse has reached the
desired size and you release the mouse button, a radius will appear in
the ellipse, extending from its center to its edge, and this radius will
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follow the pointer as you move it around the circle. Move the radius
into the position where you want one boundary of the circle pie or
ellipse segment and click once. A second radius will appear, tracing
out the final shape of your object as you move the mouse. Move the
second radius until your shape resembles the desired fragment and
click once more to place it on the page.

Arcs and circle arcs can be completed in the same was as circle pies.

3.5.3 Drawing curves and lines

Lines and arrows

Use the lines and arrows button to chose from a selection of straight
lines, and different arrow styles. Drawing lines and arrows is straight-
forward. Select the type of line you wish to draw from the main tool-
bar. The pointer will turn into a cross-hair, indicating that you may
now draw the line on the page. Click once on the page at the point
you want the line to begin, and again at end-point of the line.

Curves

Curves are more complicated than lines. Click on the the curve icon
in the main toolbar. To draw a smooth curve, follow these steps:

1. Click on the page at the point where you want the curve to begin,
and keep the mouse button held down.

2. Still holding the mouse button, move the pointer away from the
starting point. The curve’s initial direction will be from its start-
ing point toward the place where you now release the mouse
button.

3. After you’ve released the mouse button, the end of the curve
will follow the pointer. When the curve resembles the shape you
want, press (and hold) the mouse button again to fix the curve
in place.

4. At this point you can stop if you wish, by releasing the mouse
button and clicking again (a double-click).
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5. If you wish to continue the curve, don’t release the mouse but-
ton after fixing the first segment. You can continue the curve
from step 2 again.

3.5.4 Including text in drawings

You can include text in your picture using the text icon from the
main toolbar. Click on the text icon, and drag out a delimiting box in
the shape of a rectangle on the page. This sets out place your text till
appear on the page, and it’s maximum width.

Type your text into the text box. At this stage you apply the usual
text formatting from the object bar, changing the font, size and color
or emphasizing it with bold, italic of underline effects. When you’re
done, click on the page outsize the text area to place the text fragment
on the page. If you now click once on the text, it will selected in
its entirety and you can treat it like any other graphical object, for
example moving it around the page or rotating it. It you need to alter
the text itself again, double click on the object.

3.5.5 Moving and editing objects

To move an object, simple click on it and drag it its new position.
Resizing an object can be done by single-clicking on it to reveal the
”edit points” along its edges, then dragging these points to extend or
shrink the object in the chose dimension.

Rotating an object

To rotate an object, select the object and click on the rotation icon

from the effects menu on the toolbar . A series of red dots will
appear around the border of the figure. Click on a corner dot and
hold down the mouse button. With the mouse button still held, move
the mouse and the object will be rotated in the same direction. When
you have the object at the desired rotation, release the mouse button.
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Formatting objects with the object bar

You can use the object bar to modify basic properties of a drawn
object, such as color and size. First, select the object you wish to
modify by clicking on it, then choose a button from the object bar:

• Edit points. Clicking this button places a series of ”edit
points” around the selected object. By dragging on the edit
points you can enlarge or shrink the object in any dimension.

• Line. The line button brings up a dialog that allows you to
edit the size and style of lines, including the borders of shapes.
Using this dialog you can have choose to have the selected line
appear as solid, dashed or dotted and at any specified thickness.

• Arrow style. Use this button to change the appearance of the
ends of lines, turning them into arrows, pointers, bullets etc.

• Line style, width, and color. These drop-
down menus provide a quick way to modify some of basic as-
pects of the select line’s (or border’s) appearance.

• Area. Clicking on the area button opens a window where you
can specify how to format the selected object’s area, including
coloring and transparency.

• Filling. These drop-down menus let you change
the color or gradient of a solid object.

• Shadow. Clicking this button will create a ”drop shadow”
behind the selected object.

3D effects

You can convert a simple 2-dimensional shape into a more complex,
3D shape. There are two ways to do this:

• Select the object you want to make 3D, and choose from the
menu bar MODIFY>CONVERT>TO 3D. This creates 3D objects
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by ”extrusion”, for example a circle will become a cylinder and
rectangle becomes box shape.

• Alternatively, select an object and choose Modify>Convert>To
3D Rotation to create a 3D object by rotating it in the third
dimension. In this case, a line will become a cone and circle
becomes a torus.
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4.1 Opening and saving documents

4.1.1 How to simplify your work using Samples and
Templates

With SOT Office you will receive a great number of example docu-
ments and document templates. You can obtain these through the
menu command File - New - Templates and Documents or even sim-
pler via the key combination SHIFT CTRL N.

If you call up one of the templates, a new document is created based
on this template. Use the various AutoPilots (under File menu) to
create user-defined templates, for example, for faxes, presentations
or web pages which you can use as a basis for further documents.

Use the provided templates directly or to learn the techniques in
working with SOT Office. If you design a bulletin, write a book or
administrate your finances, forms or contracts or even design a CD
Cover, you’ll definitely find that SOT Office has the desired template
for these and many more tasks.

4.1.2 Turning off URL recognition by AutoCorrect

When you enter text, SOT Office automatically recognizes a word
which may be a URL and replaces the word with a hyperlink. SOT
Office formats the hyperlink with direct font attributes (color and un-
derline) whose properties are obtained from certain character styles.

If you do not want SOT Office to automatically recognize URLs as you
are typing, there are several ways of turning off this feature:

Undo URL recognition

• When you are typing and notice that a text has just been au-
tomatically converted into a hyperlink, press the shortcut keys
(Command)(CTRL)(Z) to undo this formatting.

• If you do not notice this conversion until later, select the hyper-
link and choose Format - Default.

Turn off URL recognition
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1. Load a document of the type for which you want to modify the
URL recognition. If you want to modify the URL recognition for
text documents, open a text document.

2. Choose TOOLS - AUTOCORRECT. (In SOT Office Writer, choose
TOOLS - AUTOCORRECT/AUTOFORMAT.)

3. In the AutoCorrect dialog, go to the Options tab.

4. If you unmark URL Recognition, words will no longer be auto-
matically replaced with hyperlinks.

4.1.3 Changing the title of a document

In the title bar, amongst other information, SOT Office shows the title
of the current document.

When you create and save a document for the first time, the title is
the same as the file name.

This is how to change the title of the current document

1. Choose FILE - PROPERTIES. This opens the Properties of dialog.

2. Click on the Description tab.

3. Enter the title in the Title box and click on OK.

4.1.4 Opening documents

1. Press the shortcut keys CTRL O.

You will see the Open dialog.

2. Select the file you want and click on Open.

How can you make your document open at the page position (on page
30, for example) you were on when it was closed?

Choose TOOLS - OPTIONS - SOT OFFICE - VIEW tab and mark Editing
view.
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4.1.5 Saving documents

Press the shortcut keys CTRL S.

The document is saved under its path and name on the current local
data medium or network drive or on the Internet, overwriting any old
version in the process.

When you save a new file for the first time, the Save As dialog opens,
in which you can enter a name, folder and drive or volume for the
file. To open this dialog, choose FILE - SAVE AS.

You can enter settings such as AutoSave or automatic creation of a
backup copy under TOOLS - OPTIONS - LOAD/SAVE - GENERAL.

4.1.6 Saving documents in Microsoft format

1. Choose FILE - SAVE AS. You will see the Save as dialog .

2. In the Save as type list box, select a Microsoft format.

3. Enter a name in the File name box and click on Save.

4.1.7 Relative and absolute links

When you include hyperlinks, (at least) two factors must be taken
into account, namely whether they are set as relative or absolute on
saving, and whether or not the file is present:

SOT Office behaves differently depending on the setting entered un-
der TOOLS - OPTIONS - LOAD/SAVE - GENERAL, where you can choose
whether the links should be created in relative or absolute fashion on
saving. Relative addressing is only possible when the output docu-
ment and the destination of the link are on the same drive.

You should create the same directory structure on your hard disk as
that which exists in the web space hosted by your Internet provider.
Call the root directory for the homepage on your hard disk ”home-
page”, for example. The start file is then ”index.htm”, for example,
the full path being ”C:\homepage\index.htm”. The URL on your In-
ternet provider’s server might then be as follows:
”http://www.myprovider.com/mypage/index.htm”. With relative ad-
dressing you indicate the link relative to the location of the out-
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put document. For example, if you placed all the graphics for your
homepage in a subfolder called ”C:\homepage\images”, you would
need to give the following path to access the graphic ”picture.gif”:
”images\picture.gif”. This is the relative path, starting from the loca-
tion of the file ”index.htm”. On the provider’s server, you would place
the picture in the folder ”mypage/images”. When you transfer the
document ”index.htm” to the provider’s server via the File - Save As
dialog, if you have marked the option Copy local graphics to Internet
under TOOLS - OPTIONS - LOAD/SAVE - HTML COMPATIBILITY, SOT
Office will automatically copy the graphic to the correct directory on
the server.

An absolute path such as ”C:\homepage\graphics\picture.gif” would
no longer function on the provider server. Neither a server nor a com-
puter of a reader needs to have a C: hard drive: (operating systems
such as Unix or MacOS do not recognize drive letters) and even if the
folder homepage\grahics existed your picture would not be available.
It is better to use relative addressing for file links.

A link to a web page, e.g., ”www.stardivision.com” or
”www.myprovider.com/mypage/index.htm” is an absolute link.

SOT Office also reacts differently, depending on whether the file re-
ferred to in the link exists, and where it is located. SOT Office checks
every new link and sets a target and protocol automatically. The re-
sult can be seen in the generated HTML code after saving the source
document.

The following rules apply: A relative reference ”graphic/picture.gif” is
only possible when both files exist on the same drive. If the files are
on different drives in your local file system, the absolute reference
follows the ”file:” protocol ”file:///data1/xyz/picture.gif”. If the files
are on different servers or if the target of the link is not available, the
absolute reference uses the ”http:” protocol
”http://data2/abc/picture.gif”.

Therefore, be sure to organize all files for your homepage on the same
drive as the start file of the homepage. In this way, SOT Office can set
the protocol and target so that the reference on the server is always
correct.

When you rest your mouse on a hyperlink, a help tip displays the
absolute reference, since SOT Office uses absolute path names in-
ternally. The complete path and address can only be seen when you
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view the result of the HTML export, i.e., by loading the HTML file as
”Text” or opening it with a text editor.

4.1.8 File name expansion (AutoComplete)

The names of directors and folders are automatically expanded or
entered in the URL field and dialogs for opening and saving files, pro-
vided the CursorUp (ArrowUp) or CursorDown (ArrowDown) key is
pressed. If, for example, you have just opened the document ”Let-
ter1.swx” from your document folder C: \Docs , you will see the fol-
lowing URL in the URL field: ”file:///C|/Docs/Letter1.sxw ”. If
you now wish to open an additional document ”Letter to company
XYZ regarding the new contract.sxw” that is located in its own folder,
proceed as follows:

• Click in the URL field to select the existing path.

• Press the arrow right key to remove the selection and set the
cursor at the end of the entry.

• Delete with the RETURN key as many characters until only the
beginning of the new file name remains. In this example, delete
from the displayed file name ”Letter1.sxw” the last character so
that only ”Letter” remains.

• Now press the CursorDown (ArrowUp) key. SOT Office shows
the next file whose name begins with ”letter”.

• As soon as the required file is displayed, press the ENTER key.

As soon as you press ENTER, the current document will be replaced
by the selected document. If you want to open a new document with-
out closing the active document, press the (CTRL) key in addition to
the ENTER key.

If the URL combo box in the function bar is highlighted, you can
browse through the URL list box using your arrow up or arrow down
keys. Press the Enter key or CTRL + ENTER to open a document from
the hard disk or the Internet. Press (PAGE UP) or (PAGE DOWN) keys
to display the first or the last document from the list.

If you have opened a file from the URL field, remember to position the
cursor in the document before using the arrow keys to scroll through
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the page. You can also use the ESCAPE key instead of a mouse click
to set the cursor back to the document. Press twice the ESCAPE key
if the URL is highlighted or only once if it is not. If you do not set
the cursor in the document you will move up and down the entries
contained in the URL list.

4.1.9 Quickly opening files without a dialog

To open a file from the same folder of a currently opened file, which
has only a slightly different name, you can quickly select this new file
using the URL field in the Function bar.

Click on the URL field at the left of the Function bar. The content of
the field will be selected, which indicates that you can enter a new
name. However, you can also click within the name, directly where
you want to make a change. Or you can use the arrow keys to move
the cursor within the name and modify it as necessary.

Pressing the ENTER key will replace the current document with the
document named in the URL.

Keeping the (CTRL) key pressed while pressing the ENTER key will
additionally open the document named in the URL.
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4.2 Using Windows, Menus and icons

4.2.1 Turning extended tips on and off

The Extended Tips function shows you not only the function name
but also a brief description of the function, when you allow the cursor
to pause over a button, another control or an icon. To turn Extended
Tips on and off permanently:

• On the menu bar of the application, click on Help and select
Extended Tips.

A tick against the menu item indicates that the Extended Tips func-
tion is enabled. To turn Extended Tips on temporarily:

• Press the shortcut keys SHIFT F1 to enable Extended Tips once.

A question mark appears beside the mouse pointer. You can move
this Help Mouse Pointer over all controls, icons and menu items to
obtain a short description of the command in question. The Help
Mouse Pointer is disabled the next time you click the mouse.

4.2.2 Customizing toolbars

Remarks: The drag and drop function with ALT key pressed only
works under Windows.

If you want to copy an icon, say from an object bar to the function bar,
so that it is always visible, simply hold down the ALT key and drag
the icon to its new location. SOT Office automatically remembers the
configuration of the toolbars.

To delete an icon, drag it away from its toolbar (in this case the Func-
tion bar) while pressing the ALT key and then release the mouse but-
ton anywhere outside the Toolbar.

If you want to have a separating line in the toolbar, drag an icon
slightly to the right while holding down the ALT key. To delete a sep-
arating line, drag the icon to the right of the separating line slightly
to the left while holding down the ALT key.
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The context menu of the toolbars contains a Visible Buttons com-
mand. This opens a submenu with a list of predefined icons. Icons
with ticks beside them are visible on the toolbar in question. Click
on an item to switch the icon from visible to hidden and vice versa.

You can also use the Visible buttons command in the context menu
of the toolbars to have a quick overview of the icon names and their
functions.

4.2.3 Using floating toolbars

The Insert icon appears at the top of the Main toolbar in a text doc-
ument. Click on the icon and hold down the mouse button until a
toolbar containing additional icons appears.

Figure 4.1: A floating toolbar

You can now choose the icon representing the object you want to
insert. Continue to hold the mouse button and then select the icon,
or drag the entire floating toolbar away from the Main toolbar and
position it anywhere on the screen. Like other windows, it has a Title
bar and a close box. You can move the window by dragging the title
bar.

4.2.4 Navigation to quickly reach an object

This is the most practical use of the Navigator.

• Double-click an object in the Navigator to jump directly to the
position of the object in the document.

• You can use the Navigation floating toolbar to scroll to the pre-
vious or next object of a specific category.
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Figure 4.2: The floating navigation toolbar

• You call up the floating toolbar using the Navigation icon below
to the right of the document window or on top to the left in
navigator.

• In the Navigation floating toolbar you first select the category
then click on one of the buttons to the right - Previous Object
or Next Object. The names of the buttons refer to the category,
for example, the button for scrolling is named depending on the
”Next Page” or ”Next Bookmark” category.

4.2.5 Navigator for overview of document

For simplicity’s sake, all contents of the Navigator window are re-
ferred to here as ”categories,” whether titles, sheets, tables, text frames,
graphics, OLE objects, sections, hyperlinks, references, indexes or
notes.

The Navigator displays all types of object contained in a document.
If a plus sign appears next to a category, this indicates that at least
one object of this kind exists. If you rest the mouse pointer on the
category name for a moment, the number of objects is displayed in
an extended tip.

Open an entry by clicking on the plus sign. If you only want to view
the entries in a certain category, select the category and click the
Toggle Content View icon. Until you click the icon again, only the
objects of this category will be displayed.

If the window of the docked navigator too small, turn it into a free
window (double click on the gray area with the CTRL key). You can
then freely change the size.
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4.3 Copying data via Drag & Drop or menu

4.3.1 Drag & Drop within a SOT Office document

There are many possibilities of moving or copying objects using drag
& drop. Selected text, text areas, drawings, graphics, buttons and
other form functions, hyperlinks, table areas and many more can be
moved with the mouse. Pay attention when dragging using the mouse
pointer. The mouse pointer shows a plus sign when copying and an
arrow when making a connection or hyperlink.

Figure 4.3: Mouse pointer states

If you press CTRL or both keys SHIFT CTRL when releasing the mouse
key, you can often influence whether you copy or move, or establish
a link. Drag the object from the Navigator and drop it using the sub-
menu of the Drag Mode icon.

You can cancel a drag & drop operation in SOT Office at any time by
pressing the ESC key before releasing the mouse button.

4.3.2 Drag and drop with the data source view

The simplest and quickest way of transferring data from a data source
into a text or spreadsheet document, or creating forms based on a
data source, is the drag and drop method.

Copying with Drag & Drop

If you make a mistake during drag & drop and want to reverse the
function, position the cursor in your document and select the Undo
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command in the Edit menu (or via the keyboard).

Here we describe how to transfer data from a data source into a doc-
ument. Working in the opposite direction, you can likewise copy by
drag and drop: Simple text can also be copied by drag and drop from
a document into a data field. The Reference Help explains how to do
this.

Using Data in a Text Document

You can insert a database field in a text document by dragging a
field name from the column header of the data source view into the
document. This inserts a field for this database field in the document.
This is especially useful when designing form letters. Simply drag
the desired fields - home address, form of address etc. - into your
document.

The best way to insert a complete record is to select the corresponding
header and drag it into the document. When you release the mouse
button, the Insert database columns dialog appears, where you can
decide whether to use all database fields, and whether to copy the
data into the document as text, a table or fields. All currently selected
records will be inserted.

Applying data to a table document

You can insert one or more records into the current sheet of a spread-
sheet by selecting the rows in the data source view and dragging and
dropping them into the spreadsheet. The data is inserted in the place
where you release the mouse button.

Inserting controls in a text form

When you create a text form linked to a database, you can generate
controls by drag and drop from the data source view:

When you drag a database column into the text document, you insert
a field. If you hold down SHIFT CTRL while dragging, a text field
is inserted, grouped with an appropriate label field. The text field
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already contains all the database information which you need for the
form.

4.3.3 Copying graphics from the gallery

If you drag a graphic from the gallery into a text, spreadsheet or
presentation document, the graphic will be inserted there.

If you release the graphic directly on a drawing object, please note
the following:

If you move it (drag it without pressing any key, in which case no
additional symbol appears next to the mouse pointer), only the font
attributes are copied from the graphic and applied to the drawing
object on which you release the mouse button.

If you copy it (drag it while holding down the CTRL key, in which case
a plus sign appears next to the mouse pointer), the graphic will be
inserted as an object.

If you create a hyperlink (drag while holding down SHIFT and CTRL,
in which case a linking arrow appears next to the mouse pointer), the
drawing object is replaced by the graphic from the gallery, but the
position and size of the replaced drawing object are retained.

4.3.4 Inserting graphics from a document in the gallery

You can place a graphic - from an HTML page, for example - in the
gallery by drag-and-drop.

1. Display the gallery theme which you want to add the graphic to.

2. Position your mouse pointer above the graphic, without clicking.

3. If the mouse pointer changes to a hand symbol, the graphic
refers to a hyperlink. In this case, click the graphic while press-
ing the ALT key to select it without executing the respective link.

If the mouse pointer does not change to a hand symbol, you can
simply click the graphic to select it.

4. Once the graphic is selected, release the mouse button. Click
again on the graphic image, keeping the mouse button pressed
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for more than two seconds, to copy the graphic image to an
internal memory.

5. Without releasing the mouse button, drag the graphic into the
gallery.

4.3.5 Copying sheet areas to text documents

1. Open both the text document and the spreadsheet.

2. Select the sheet area you want to copy.

3. Point to the selected area and press the mouse button. Keep the
mouse button pressed for a moment, then drag the area into the
text document.

If the documents are not visible side by side, first move the
mouse pointer to the button of the target document. Keep the
mouse button pressed! The document in question is then dis-
played and you can move the mouse pointer into the document.

4. Once the cursor is located in the place where you want to insert
the sheet area, release the mouse button. The sheet area is
inserted as an OLE object.

5. You can select and edit the OLE object at any time.

6. To edit the OLE object, simply double-click on it.

Alternatively, select the object and choose EDIT - OBJECT - EDIT

or choose Edit from the context menu. You edit the object in its
own frame within the text document, but you see the icons and
menu commands needed for spreadsheets.

7. Choose OPEN to open the source document of the OLE object.

4.3.6 Inserting an object from the gallery

You can insert an object in a document either as a copy or as a link. A
copy of an object is independent of the original object. Changes to the
original object have no effect on the copy. A link remains dependent
on the original object. Changes to the original object are also reflected
in the link.
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Inserting an object as a copy

1. Open the gallery.

2. Select a theme in the left area.

3. Select the object by a single click.

4. Drag the object into the document or right-click to open the
context menu and choose INSERT AND COPY.

Inserting an object as a link

1. Open the gallery.

2. Select a theme in the left area.

3. Select the object by a single click.

4. Drag the object into the document while pressing the (SHIFT)
and (CTRL) keys, or right-click to open the context menu and
choose INSERT AND LINK.

Inserting an object as a background graphic

1. Open the gallery.

2. Select a theme in the left area.

3. Select the object by a single click.

4. Open the context menu and choose INSERT - BACKGROUND -
PAGE OR PARAGRAPH.

Inserting an object as a texture (pattern) for another object

1. Open the gallery.

2. Select a theme in the left area.

3. Select the object by a single click.

4. Drag the object on to the other object in the document while
pressing (CTRL).



54 CHAPTER 4. SOT OFFICE GENERAL HELP

4.3.7 Copying graphics between documents

You can copy a graphic from one document to another by drag-and-
drop. If you plan to publish your document, please observe copyright
laws and, for safety, obtain the consent of the authors of the original.

1. Open the document where you want to insert the picture.

2. Open the document from which you want to copy the graphic.

3. Click on the picture while pressing the ALT key, to select it with-
out executing any hyperlinks it may refer to.

4. Keep the mouse button pressed and wait a moment while the
object is copied to your clipboard.

5. Drag the graphic into the other document. If the documents
are not visible side by side, first move the mouse pointer to the
button of the target document. Keep the mouse button pressed!
The document in question is then displayed and you can move
the mouse pointer into the document.

6. Release the mouse button as soon as the gray text cursor indi-
cates the position where you want to insert a copy of the picture.

If the graphic is connected with a hyperlink, the hyperlink and not
the graphic is inserted.

4.3.8 Inserting data from table documents

If you only want to copy the contents of a cell (text or numbers), use
the clipboard. You can even copy formulas that are in the cells into
the clipboard (e.g., from the input lines of the formula bar) so that
they can then be inserted into a text.

If you want to copy a simple, rectangular area of cells into a text
document as a sheet, select the cells in the sheet and then use either
the clipboard or drag & drop to insert them into the text document.
You will then find an OLE object in the text document which you can
edit further if you want.

If you drag table cells to the character preview of a presentation doc-
ument, they will also re-appear there as OLE objects. Once dragged
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into the outline preview, each cell will form a line of the outline pre-
view. Dragging using drag & drop will move the cells. If you press the
shift key when dragging, it will be copied.

4.3.9 Copying a drawing in another document

In SOT Office it is possible to directly copy drawings between text,
table and presentation documents.

1. Select the drawing or drawings.

2. Copy the drawing to the clipboard, for example, by using CTRL

C.

3. Switch to the other document and place the cursor where the
drawing is to be inserted.

4. Insert the drawing to the target position, for example, by using
CTRL V.

Inserting in a text document

An inserted object is anchored to a text document at the current
paragraph. You can change the anchor by selecting the object and
clicking on the Change Anchor in the object toolbar. This opens a
popup menu where you can change the possible types of anchor.

Figure 4.4: Anchoring an inserted object

Inserting in a table document

An inserted object is anchored to a table document in the current
cell. You can change the anchor between cell and page and back by
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selecting the object and clicking on the Change Anchor in the object
toolbar.

4.3.10 Inserting data from text documents

You can transfer texts into spreadsheets and presentations. When
doing this, you have to determine whether the text should be placed
into a frame of its own which can be moved anywhere on the screen,
or whether it should be transferred into either a cell in the spread-
sheet or the outline of the presentation.

If you transfer text via the clipboard, you can insert it complete with
its text attributes at its target destination. The quickest way to do this
is to use the shortcut keys CTRL+C to copy and CTRL+V to insert.

In a text document you will find the SEND - OUTLINE IN PRESEN-
TATIONS command in the File menu. A new presentation document
that contains the headings from the text document as an outline is
created.

If you wish to also send the initial subordinate text paragraph (or
more paragraphs) to the headings, select the AutoAbstract in Presen-
tations command. copying text using drag & drop

If you select a text section and drag it into a spreadsheet with drag
& drop, it will be inserted as text into the cell where you release
the mouse. If you drag a text section to the character preview of a
presentation, an OLE object is inserted as a SOT Office plugin. If
you drag the text to the outline preview of a presentation, it will be
inserted where the cursor is.

4.3.11 Adding special characters

Here’s how to insert special characters (e.g. checks, boxes, or tele-
phone icons) into your text.

You get a selection of all the characters through the menu item ADDING

- SPECIAL CHARACTERS.

In any text input field (e.g. in the URL field of the Function Bar or in
the input fields in the Search& Replace dialog) you can press SHIFT

CTRL S to call up the Special characters dialog.
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4.4 Data sources

4.4.1 Exporting data from Databases

If you only want to export certain records from an opened SOT Office
Database table, select those records which you would like to export
into a text document. To select multiple records, press SHIFT and/or
CTRL.

Don’t release the mouse button after selecting the last record. In-
stead, drag the selected data into an open SOT Office Calc spread-
sheet.

You can now save the SOT Office Calc spreadsheet in the desired
format.

4.4.2 Searching in tables and forms

You can find texts and values in tables and forms by clicking the
Search icon to access the search dialog.

You can search in all data records or in all data fields. You can select
whether the text must be at the beginning, end or any location of
the data field. You also can use the ? and * placeholders, as with
the Search and Replace dialog. You can find additional information
about the database search function in the Help.

4.4.3 Inserting and editing buttons

1. Open the Form Functions floating toolbar.

2. Click the Push Button icon from the Form Functions floating
bar. The pointer will change to a cross-hair symbol.

3. In the document, drag open a box representing the size and
position of the command button you want to insert.

The new button is selected.

4. To select a button, click on the edge, there where the mouse
pointer appears with a cross with four arrows, or hold the ALT

key pressed.
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You can move and scale a selected button like a graphic. You can call
up dialogs for editing properties via the context menu of the button.

Select the Control command from the context menu of the selected
button for accessing the Properties: Button dialog. You can also call
this dialog by clicking the Control Properties icon contained in the
Form Functions floating bar.

Figure 4.5: Setting a button’s properties

You can change the text on the button in this dialog under GENERAL

-TITLE.

Use the Events tab if you would like to run a macro when the button
has been clicked. Click the suspensive points button at the right to
access a selection dialog for macros.

The Events tab contains all possible events to which a control can
react. Select a macro which has to run when the button is clicked
and then confirm your selection by clicking the ASSIGN button. You
can use custom macros for this function.

End the design mode using the icon in the Form Functions floating
toolbar. If you now click on your button in the document (not on the
edge), the assigned macro is executed.

In addition to the properties of the selected controls, you also can
control the properties of the form to which the control belongs. Click
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the Form Function floating bar on the Form properties icon.

Among other things, the form defines the database and table the form
controls link to.

You can link events with macros in forms with the Events tab. Doing
this lets you run a specific macro when a form is loaded, for example.

The other icons in the Form Functions floating toolbar serve to define
interactive documents. In SOT Office Basic you can also define your
own dialogs. For this purpose, there are other controls for dialogs
available to you in the SOT Office Basic IDE.
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4.5 Recording changes (Revision marking)

4.5.1 Recording and highlighting changes

When several authors are working on the same text or spreadsheet,
the review function (marking of changes, redlining) makes it possible
to document who made which changes, so that this is clear to every-
one. On the final edit of the document, it is then possible to look at
each individual change and decide whether it should be accepted or
rejected.

Imagine you are an editor and are delivering your latest report. But
before publication the report must be read by the senior editor and
the proofreader, and both will add their changes. Perhaps the senior
editor writes ”clarify” after one paragraph and crosses out another
entirely. The proofreader checks the spelling of your document and
notes two cases where explicit references to the gender of an imagi-
nary person could be reworded to avoid gender entirely.

The edited document comes back to you, and you can incorporate or
ignore the suggestions of the two reviewers.

Let’s say you also e-mailed a copy of the report to a good friend and
colleague who has done research on a similar topic in the past. You
asked for a few suggestions, and the document is now returned by
e-mail with your colleague’s suggestions.

Of course, all your colleagues and the managers in your company
work with SOT Office, so it is a simple matter to produce a final
version of the document from the results you get back.

4.5.2 Accepting or rejecting changes

When you bring your document in which others have noted their
changes back together again, you can accept or reject the changes
individually or all together.

If you have put several copies of the document in circulation, first of
all you merge these into one document (see section 4.5.4).

Open the document and choose the EDIT - CHANGES - ACCEPT or RE-
JECT... command. You will see the Accept or Reject Changes dialog.
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Select a change on the List tab. The change is selected and displayed
in the document and you can now make your decision with one of the
dialog buttons.

If one author has changed another author’s change, you will see the
changes hierarchically arranged with a plus sign for opening up the
hierarchy.

If the list of changes is too long for you, you can switch to the Filter
tab in the dialog and specify that you only want to see the changes of
certain authors, or only the changes of the last day, or that you want
the list to be restricted in some other way.

You can also filter them by the descriptions. Placeholders (as with
regular expressions in the Find & Replace dialog) are permitted when
entering the filter.

Text document changes that have not yet been accepted are displayed
in the list. Changes that have been accepted are removed from the
list and appear in the text without any further marking.

Spreadsheet changes that have been accepted are combined in the
list in a single entry, so that you can continue to see which changes
have already been accepted.

Color-coded entries inform you about the result of the filter that is
set. Entries in black can be accepted or rejected and match the filter
criteria. Entries in blue do not themselves match the filter crite-
ria, but have subentries that are included by the filter. Gray entries
cannot be accepted or rejected and do not match the filter criterion.
Green entries do match the filter but in spite of this cannot be ac-
cepted or rejected.

4.5.3 Comparing versions of a document

Perhaps one of the authors who received a copy of your document
made changes but didn’t record them by choosing the EDIT - CHANGES

- RECORD command. Depending on how nice you would like to be,
you can ask the author to do it over, but correctly this time with SOT
Office, or you can compare the delivered copy of the document with
your original document yourself.

You can also use this feature to compare configuration files and iden-
tify the differences, for example, before and after a piece of software



62 CHAPTER 4. SOT OFFICE GENERAL HELP

has been installed. Select the file type ”Text” in the file selection dia-
log if this is appropriate.

Open your original document and then choose the EDIT - COMPARE

DOCUMENT... menu command.

You see a file selection dialog where you can select the copy of the
document. Confirm the dialog.

Now SOT Office combines both documents in your original document.
All text passages that occur in your document but not in the copy
are identified as having been inserted, and all text passages that are
missing in your original document are identified as deletions.

You can now accept the ”insertions”, in which case the relevant texts
stay in their original form, or you can accept the ”deletions”, in which
case the marked text contained in the copy are not inserted in your
document.

4.5.4 Merging versions

It is not always one and the same document that is edited by different
authors and passed from one to the next author. It often makes more
sense to give a separate copy of the document to each author. In our
example, this means you’ll receive three copies back in addition to
the original document, with different changes in each copy.

It is easy to merge these documents into your original. The only
requirement is that the documents differ only and exclusively in the
recorded changes - all ”normal” text must be identical.

Open your original document in which you want to merge all the
copies.

Choose EDIT - CHANGES - MERGE DOCUMENT.... You’ll see a typical
file selection dialog in which to select a copy of the document.

After you merge the documents you will see the designated changes
from the copy in the original document.

4.5.5 Recording changes

The review function is available in SOT Office for text documents
and spreadsheet documents. Not all changes are recorded (for ex-



4.5. RECORDING CHANGES (REVISION MARKING) 63

ample, the changing of a tab stop from align left to align right is not
recorded). However, all usual changes made by a proofreader are
recorded, such as additions, deletions, text alterations, usual for-
matting etc.

To start Revision Marking, open the document to be edited and go to
EDIT - CHANGES and put a check in front of the Record command.

Now start making your changes. You will note that all new text pas-
sages you enter are underlined in color, while all text that you delete
remains visible but is crossed out and shown in color.

If you move to a marked change with the mouse pointer, you will see
a reference to the type of change, the author, date and time of day
for the change in the Help Tip. If the Extended Tips are also enabled
(on the Help menu), you will also see any available comments on this
change.

Changes in a spreadsheet document are highlighted by a border
around the cells; when you point to the cell you can see more de-
tailed information on this change in the Help Tips.

You can enter a comment on each marked change by placing the
cursor in the area of the change and then choosing EDIT - CHANGES

- COMMENT.... In addition to Extended Tips, the comment is also
displayed in the list in the Accept or Reject Changes dialog.

To stop recording changes, choose EDIT - CHANGES - RECORD again.
The check mark is removed and you can now save the document and
return it to the person who asked for the changes.

In a text document, you can highlight all lines which you have changed
with an additional marking. This can be in the form of a red line in
the margin, for example.

You can select the type of additional selection under TOOLS - OP-
TIONS... - TEXT DOCUMENT on the Changes tab or under TOOLS -
OPTIONS... - SPREADSHEET DOCUMENT on the Changes tab. Here
you can determine how and in what color the changes should be
flagged, where on the page the dash should be and so forth.
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4.5.6 Protecting record

You can record the changes made in a document by choosing EDIT -
CHANGES - RECORD or EDIT - CHANGES - PROTECT RECORDS. If you
choose PROTECT RECORDS, you must enter the correct password in
order to turn off the function or accept or reject changes.

1. Choose PROTECT RECORDS. This opens the Password dialog.

2. Enter a password consisting of at least 5 characters and confirm
it. Click OK.

4.5.7 Version management

The File menu contains a Versions command. The Versions function
allows you to save several versions of the same document.

You can choose to view individual versions of a document, or you can
display the differences between versions with color markings.

In the dialog to open a document, you can choose from a list box
which version of this document you want to open.
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4.6 Configuration

4.6.1 Fast spell-check

You can add all unknown words in a text document to the active user
dictionary with a single command. However, you yourself first have
to assign the command to shortcut keys or to a separate icon.

1. Open a text document.

2. Choose the TOOLS - CONFIG... command. The Configure dialog
appears.

3. Select the Keyboard tab to specify a key combination. Select the
Toolbars tab to specify an icon for this function.

4. Here we describe the procedure for modifying the shortcut keys.
To find out how to reconfigure a toolbar, see the instructions for
creating a fax icon.

5. Select the Tools area at the lower left of the Keyboard tab, and
then select the Adding unknown words function next to it.

6. Search for an available key combination in the Keyboard list box
(e.g. F10).

7. Double-click the entry and close the dialog with OK.

You can now use the selected key or key combination to perform a
spellcheck in the active text document and to automatically add all
unknown words to the activated user-defined dictionary.

To include the unknown words in a dictionary, you must fulfill the
following conditions:

• The dictionary should be activated.

• This dictionary cannot be a ”negative dictionary”.

• The language of the dictionary has to be set up on ”All”.

• The dictionary file canot be a read-only file.
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4.6.2 Configuring SOT Office

You can customize your SOT Office to suit your needs.

You are free to change the items on the menu bar. You can delete
items, add new ones, copy items from one menu to another, rename
them, and so on.

The toolbars are freely configurable. You can drag and drop icons
while holding down the ALT key.

You can change the shortcut keys according to your wishes.

To change these, choose TOOLS - CONFIGURE to open the Configura-
tion dialog.

4.6.3 Saving configuration with document

You can set a global configuration (so that it applies to all documents
of this type), or you can connect the configuration to a specific docu-
ment, which must exist as a file.

1. Load the document you want to connect to the configuration or
open any document of the same type.

2. Set the configuration. For example, select the Toolbars you want
to be visible or define the Toolbar assignment, menu or Sta-
tus Bar items, etc. All configuration-setting options are in the
TOOLS - AUTOFIT... dialog.

3. Click Save... in the Tools - AutoFit... dialog. Another dialog
appears in which you can save the configuration.

4. In the File Type list box, select <All>.

5. In the large list box of the Save dialog, select the file you want
to connect to the configuration.

6. Click SAVE. A prompt appears, asking whether you want to re-
place the file or not. This query concerns only the configuration
connected to the document, not the ”actual” contents of the doc-
ument.

7. Confirm overwrite.
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The configuration is now connected to the active document. You can
check this by loading the document and opening the FILE - DOCU-
MENT TEMPLATE - ORGANIZER dialog, then double-clicking the docu-
ment.

As soon as you load or open this document, it switches to the saved
configuration. The global default configuration are restored if you
load or open another document that does not contain custom con-
figuration information. You can select manual settings at any time
by opening the TOOLS - AUTOFIT... dialog and clicking the RESET

button.

4.6.4 Sending a fax and configuring SOT Office for
faxing

If you wish to send a fax directly from SOT Office, you need a fax
modem and a fax driver that allows applications to speak to the fax
modem like a printer. Fax modems are usually supplied with Win-
dows drivers. To use a fax modem under GNU/Linux, install the efax
package, available from http://www.cce.com/efax/

Send a fax through a dialog as follows

Print the current document with the fax machine as a printer:

1. Call up the Print dialog through the FILE - PRINT SETTINGS com-
mand and select the fax driver in the Name combo box.

2. Clicking on OK will open the dialog of your fax driver where you
can enter the fax recipient.

Configure SOT Office for faxing through the icon as follows

You can configure faxing from SOT Office in such a way that a single
click on one icon is sufficient to send a fax:

1. 1.Open TAGS - OPTIONS - TEXT DOCUMENT - PRINT.

2. Select the Fax combo box of your fax driver and close the dialog
by clicking on OK.
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3. Open the context menu in the function toolbar and click on Vis-
ible Buttons.

You see a list of immediately configurable buttons for this icon
toolbar. All buttons that are currently visible have a mark.

4. Select by clicking the Send Standard Fax button in the context
menu.

The button is now visible in the function toolbar. By clicking on it the
fax driver entered in step 2 is activated to send the current document.

4.6.5 Changing icon view

You can change the icon view between the flat icons and the 3D icons.

1. Call up the TAGS - OPTIONS - SOT OFFICE command.

2. Remove the mark in front of Flat Buttons in the View tab page.

3. Click OK to confirm the new settings and close the dialog.

The Flat Icons check box switches between flat and 3D views. The
Large Icon check box switches between large and small icons.

4.6.6 Insert, move and delete icon in the icon tool-
bar

We will show you later how you to deal with all the functions possible
in SOT Office (including self-writing macros) to connect a function as
an icon in an icon toolbar.

We use the example of an ”icon for faxing the current document”
to give you a comprehensive explanation of the basic steps needed.
Many, but not all, of the functions we choose can be inserted through
the context menu of an icon toolbar quicker and easier. For the
fax icon you will find instructions for quick insertion under the ti-
tle ”Sending Faxes and Configuring SOT Office for Faxing”.

1. Open a text document.
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2. Open the context menu of the function toolbar and select the
EDIT command.

3. Select the Send Standard Fax function in the Documents func-
tion area in the dialog.

4. If no appropriate icon is displayed for this function, click Icons...
to view a wide selection of buttons. Confirm your choice with
OK.

5. Now, drag the desired icon from the dialog to the Function bar,
and release the mouse button where you want the new icon to
be positioned. Close the dialog.

6. If you wish to move this icon to a new position, drag it to the
new place all the while keeping the ALT key pressed.

7. If you wish to remove an icon from an icon toolbar, remove it
from the icon toolbar all the while keeping the ALT key pressed.

Before you can send a fax, you must select your fax driver in the Fax
field on the Print tab under TOOLS - OPTIONS - DOCUMENT...

4.6.7 Selecting measurement units

You can choose separate measurement units for SOT Office Writer,
SOT Office Writer/Web, SOT Office Calc, SOT Office Impress and SOT
Office Draw documents.

1. Choose TOOLS - OPTIONS.

2. Click on the document type for which you want to select the
measurement unit.

Click on Text Document if you want to select the measurement
unit for SOT Office Writer.

3. Click on General.

4. On the General tab, under Settings, is a combo box for selecting
the measurement unit. Close the dialog with OK.
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4.6.8 Changing default templates

When you open a new document with FILE - NEW a blank document
appears based on a SOT Office template. You can edit or modify
this document or replace it with an existing document so that the
new document contains your customized format attributes or other
contents.

Modifying Default Templates

First, open a new document and edit it until you feel it would make a
good template. This doesn’t apply, of course, if you’ve already found
a SOT Office document which satisfies your needs.

You can define templates for all SOT Office applications. As this
option is most interesting for text documents, we’ll describe here how
to create a template for one.

1. Save the document with FILE - SAVE AS....

Enter a name in the Save dialog and select a folder for the doc-
ument, e.g., ”My Templates.”

2. Now open the ”My Templates” folder or the folder where you
saved the future template.

3. Select the document, which you want to use as a template—a
text document in this example—and call up its context menu.

4. Finally, in the context menu, select Set Default Template - Text
Document. That’s all. The next time you open a new text docu-
ment, it will be based on the selected template.

Resetting Default Templates

To reset the modified text template to the original default template,
proceed as follows:

1. Using the Open dialog from the File menu, open the folder where
SOT Office is installed. Browse through the following folders:
share, config, new.
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2. Open (05) Text Document and right click in it to call up the
context menu.

3. Select the Reset Default command. If you then open a new doc-
ument it will be opened in the SOT Office default template for
text documents.

Using Custom Templates

There are several ways to make your work easier by using your own
custom templates. One of the most important is quick access to the
templates. You can store your templates in different locations in SOT
Office. Opening a new document with one of your templates will then
differ accordingly.

Templates in the template folder

You can save a new template via FILE - TEMPLATES - SAVE or select
the ”Template” file type in the ”normal” Save dialog. If you save the
template in the soto/user/template directory , you can access
this template anytime by selecting it in the New dialog (FILE - NEW -
FROM TEMPLATE). If you open the template, a new document will be
created based on this template.

You may need to update the templates’ view in the dialog before view-
ing a new created template. In this case, select in the dialog the menu
commands FILE - TEMPLATES - ORGANIZE and in the submenu of the
COMMANDS button, select UPDATE.

If you want to modify the template yourself, you can call this file via
FILE - TEMPLATES - EDIT and then edit it.

4.6.9 Moving, deleting or copying icons

Remarks: The Drag & Drop function with the ALT key pressed func-
tions only in Windows.

To move an icon keep the ALT key pressed and drag the icon to its new
position. It will be moved within the same icon toolbar and copied
within the icon toolbar.
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To delete an icon from an icon toolbar, keep the ALT key pressed and
drag the icon to a place where there is no toolbar.

To insert or delete a dash, drag the icon in the same way to the side.

4.6.10 Switching object toolbars with the context menu

The object toolbar is context-dependent. If the cursor, for example, is
pointed toward a text table, the icon for editing the table is automat-
ically prepared. If the cursor points to a bullet, you will see an object
toolbar with icons that are meaningful for the bullets.

If the cursor is in a bullet within a table, you can switch between the
possible object toolbars as follows:

Click on the last icon on the right side of the object toolbar.

Or call up the context menu of the object toolbar. You will see a list
of the possible object toolbars where you can click on the desired
toolbar.

SOT Office remembers which object toolbar you chose in the respec-
tive context and shows this first the next time.

4.6.11 Inserting and editing tab stops

You set a tab stop by clicking on the ruler. Alternatively, you can set
tab stops by choosing FORMAT - PARAGRAPH. Both methods affect the
current paragraph or all selected paragraphs.

Note: To assign tabs directly to a current Paragraph Style, open the
context menu of that paragraph and choose EDIT PARAGRAPH STYLE

to call the Paragraph Style dialog where you then enter the tabs.

Click the ruler once to set a left-justified tab. Right-click a tab icon
on the ruler to see the context menu in which you can change the tab
type.

To set several decimal tabs one after the other, keep clicking the icon
to the left of the ruler until the desired tab type is shown, then click
on the ruler.

Double-click the ruler to open the Paragraph dialog.

Double-click the white area of the ruler to set one tab. The Paragraph
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Figure 4.6: Tab markers

dialog appears with the Tabs tab page.

Moving Tabs on the Ruler

Move individual tab stops on the ruler using the mouse.

To move several tab stops on the ruler, press the SHIFT key before
you click a tab. Drag one tab while continuing to press SHIFT to
move that tab as well as all the tabs to the right of it. The spacing
between those tabs remains the same.

Press CTRL instead of SHIFT when you drag a tab on the ruler to move
that tab and all the tabs to the right of it. This results in the spacing
between those tabs changing proportionally to their distance from the
margin.

Changing the Properties of Tabs

To change tab type, click the tab you want to change on the ruler,
then open the context menu.

Deleting Tabs

Deleting a tab with the mouse is easy. Simply hold down the mouse
button while you drag the tab outside the ruler.
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Changing the Defaults

If you want to change the settings of your default tab stops, you will
find further information under TOOLS - OPTIONS - (DOCUMENT TYPE)
- GENERAL.

The context menu of the ruler toolbar allows you to change the dis-
played units to centimeters, inches, point, pica etc. These changes
are only valid until you exit SOT Office, and they only apply to the
ruler on whose context menu you made the change. If you want to
change the ruler measurement units permanently, choose TOOLS -
OPTIONS - TEXT DOCUMENT - GENERAL and change the measurement
unit there.

4.6.12 Changing the color of text

Click this icon while pressing the mouse button to display a floating
toolbar containing the available font colors. Once you choose a color,
the word in which the cursor is placed or the selected text appears in
that color.

Alternatively, when you click the icon once with no text selected, the
cursor changes its appearance to become a watering can. You can
use the vertical gray line appearing below the watering can to select
text like you would with a cursor. The selected text is then formatted
with the color selected on the Font Color floating toolbar. To end the
function and return to a normal cursor, press (ESC).

4.6.13 Switching between insert mode and overwrite
mode

With the keyboard:

Press INS to toggle between overwrite mode and insert mode. The
current mode is displayed on the status bar.

With the mouse:

On the status bar, click on the button indicating the current mode to
switch to the other mode:

INSRT
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Insert mode is enabled. Click on the button to enable overwrite mode.

OVER

Overwrite mode is enabled. Click on the button to enable insert mode.
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4.7 Charts

4.7.1 Inserting charts

1. Open an existing spreadsheet or enter data in a new sheet with
row and column headings.

2. Select the data together with the titles.

3. Long-click the Insert Object icon found in the Main toolbar to
display the floating toolbar. Then click the Insert Chart icon
and the cursor will change to a cross-hair symbol with a small
chart symbol.

4. In the spreadsheet document, open a selection rectangle defin-
ing the location and size of the chart. Both can be modified
subsequently.

5. As soon as you release the mouse button, a dialog appears in
which you can make further entries. You can also simply click
the CREATE button to create a chart with the default settings.

Figure 4.7: Creating a chart

This example shows the number of times people of different age groups
in various cities go to the movie theater annually.
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If you would rather put the age groups than the towns on the hor-
izontal axis, you can ”tilt” the chart subsequently: As long as the
chart remains selected, the main toolbar contains a Data in Columns
icon. Click on it.

You are free to make other changes to the individual elements of the
chart. You can either double-click on the individual parts of the chart
or, with the chart selected, choose the individual functions from the
Format menu. For example, if you double-click on the color preview
in the legend, you can automatically reformat all relevant data points.
On the other hand, if you click on the background in the box of the
legend, you just format the background to the legend.

If you created the chart from the data of a SOT Office Calc spread-
sheet, the data series which you click on in the chart are highlighted.

Suppose you placed the chart in your SOT Office Calc spreadsheet
in the background, and now you are wondering how to select it for
further editing. Open the Show Draw Functions floating toolbar and
choose the first tool, the Select arrow. This allows you to click on the
chart.

In a SOT Office Calc chart, you can shift a data series to the front or
to the back.The series can be ordered in such a way so that the lowest
3D presentation is positioned at the very front, and the highest at the
very back. To change the arrangement in the chart, you can use the
context menu of a data series or under the Format - Arrange menu
command. The original data in the SOT Office Calc spreadsheet will,
however, not be rearranged. It is clear that after this rearrangement,
the exchange of data from columns to rows is no longer possible.

When you insert a chart in a presentation or drawing document with
the Insert - Insert Chart floating toolbar, it is displayed with a set
of sample data. If you want to insert a chart in a spreadsheet, you
have to select the cells in the spreadsheet whose values should be
displayed in the chart.

In SOT Office Writer documents too, you can insert a chart obtained
from the data of a SOT Office Writer spreadsheet. If you have not
selected any data in a SOT Office Writer spreadsheet, choosing IN-
SERT - OBJECT - CHART inserts a chart containing sample data in
SOT Office Writer as well.

You can change the values in a chart containing sample data by
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double-clicking on the chart and then choosing EDIT - CHART DATA.
If you want to change the values of a chart obtained from selected
data, you have to alter the values in the cells of the table. If the chart
is in a text document, press (F9) to update the chart.

Modification of chart data is also possible if you, for example, have
copied a chart from a SOT Office Calc document into a SOT Office
Writer document and now double-click the chart in the SOT Office
Writer document. Remember, however, you are only editing the copy
and not the original document.

You can change the type of chart subsequently. When you double-
click on the chart and choose FORMAT - CHART TYPE, a dialog ap-
pears, presenting you with various types to choose from.

Figure 4.8: Changing the type of chart

Try out the different options in the Chart Type dialog. You can also
switch between 2D and 3D representation. With the Columns chart
type you can select a Combination Chart of lines and columns.

The three-dimensional representations make special effects possible.
In 3D charts, you can even adjust the illumination settings, such as
light source, ambient light and the color filter.

3D charts can be rotated and flipped with the mouse for optimal
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design.

By choosing INSERT - STATISTICS, you can apply statistical indicators
to XY charts, such as standard deviations, with regression curves
and more besides. A single or double logarithmic representation of
the axes can also be set here.

In line charts you can work with various icons. These can be applied
automatically by SOT Office Chart if desired. You can also select
them yourself from graphic files or from the Gallery.

4.7.2 Editing chart titles

Suppose you have inserted a chart in a SOT Office Calc document
and want to change the title.

1. Double-click on the chart.

A gray border appears around the chart and the menu bar now
contains commands for editing the objects in the chart.

2. Double-click on the default title text. A gray border appears
around the text and now you can change it. Press ENTER to
create a new line.

3. If you single-click on the title instead of double-clicking, you can
move it with the mouse.

4. Choose FORMAT - TITLE - MAIN TITLE to edit the formatting of
the main title. This opens the Title dialog.

5. Click on the Characters tab if you want to change the font.

6. Click OK. In your document, click outside the chart to exit chart
editing mode.

4.7.3 Editing chart axes

Suppose you have inserted a chart in a SOT Office Calc document
and you want to change the scale of the vertical Y axis.

1. Double-click on the chart.
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A gray border appears around the chart and the menu bar now
contains commands for editing the objects in the chart.

2. Choose FORMAT - AXIS - Y AXIS if you want to edit the Y axis, or
double-click on the Y axis. This opens the Y axis dialog.

3. Click on the Scale tab if you want to modify the scale of the axis.

4. Click OK. In your document, click outside the chart to exit chart
editing mode.

4.7.4 Add texture to chart bars

Is there a way of displaying bars in the form of graphics/textures when
creating charts?

1. You assign a bitmap to a bar type (instead of, say, a full color).

2. You switch to edit mode by double-clicking on the chart.

3. Double-click on the corresponding bar (all bars of this color are
now selected).

4. In the context menu select the Object Properties entry then the
Area tab page.

5. Click on Bitmap. You can now select a bitmap in the list box as
texture for this bar. By clicking on OK you accept the setting.

4.7.5 Editing chart legends

Suppose you have inserted a chart in a SOT Office Calc document
and want to apply a color gradient to the legend.

1. Double-click on the chart.

A gray border appears around the chart and the menu bar now
contains commands for editing the objects in the chart.

2. Choose FORMAT - LEGEND or double-click on the legend. This
opens the Legend dialog.
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3. Click on the Area tab if you want to modify the background
to the legend. From the combo box select Gradient. Select a
gradient from the list.

4. Click OK. In your document, click outside the chart to exit chart
editing mode.

You can define your own gradients, hatching, bitmaps and colors in
SOT Office Draw.

To select the legend, first double-click on the chart (see step 1), then
click on the legend. You can now move the legend within the chart
using the mouse.

If you move the legend over another object of the chart, you can no
longer open its Properties dialog by double-clicking on it. To open
the Properties dialog either use the Format menu or click once on the
legend, then open the context menu and choose Object Properties.
The same applies to all other objects of the chart.
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4.8 Miscellaneous

4.8.1 Showing Navigation Pane of the Help

In the Help window, you can show or hide the navigation pane as
needed.

On the toolbar of the Help window, click the left icon to show or hide
the navigation pane.

4.8.2 Modifying an Existing Installation

You can modify an existing installation of SOT Office by adding new
components and removing installed ones.

1. Start the Setup Program of SOT Office either via the Windows
start menu, GNU/Linux startbar, or directly from the SOT Office
installation folder.

<installdir >\program \setup.exe

or

<installdir >/setup

Where <installdir > indicates the directory in which you have
installed SOT Office.

2. Select the installation option Modify from the installation dialog
and follow the instructions on the screen. In the dialogs that
follow, you can select particular components for installation or
deinstallation.

4.8.3 Defining background colors or background graph-
ics

You can define a background color for different objects. With certain
objects you can even use a graphic as the background.

Applying a background to text characters

1. Select the characters.
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2. Choose FORMAT - CHARACTER.

3. On the Background tab, select the background color.

Applying a background to text paragraphs

1. Place the cursor in the paragraph or select several paragraphs.

2. Choose FORMAT - PARAGRAPH.

3. On the Background tab, select the background color or a back-
ground graphic.

Applying a background to all or part of a spreadsheet

1. Place the cursor in the table in your text document.

2. Choose FORMAT - TABLE.

3. On the Background tab, select the background color or a back-
ground graphic.

In the For box, choose whether the color or graphic should apply to
the current cell, the current row or the whole table. If you select
several cells or rows before opening the dialog, the change applies to
the selection.

Applying a background to a SOT Office Calc spreadsheet

1. Select the cells.

2. Choose FORMAT - CELL (or Format Cells from the Context Menu).

3. On the Background tab, select the background color.

Graphics in the background of cells

1. Choose INSERT - GRAPHICS - FROM FILE.

2. Select the graphic and click Open.
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The graphic is inserted so that it is anchored to the current cell. You
can move and scale the graphic freely. The context menu includes
a command Arrange - Send To Back, to place it in the background.
Later on you can use the Navigator, if you want to select the graphic.

Graphic in the background of printed pages (watermark)

1. 1.Choose FORMAT - PAGE.

2. On the Background tab, select the background color or a back-
ground graphic.

This background appears only in the print behind the cells not for-
matted elsewhere.

4.8.4 Editing hyperlink

Change the text of a hyperlink as follows

Option 1: Click on the hyperlink all the while keeping the ALT key
pressed.

Option 2: Click on the HYP field on the status toolbar so that SEL
appears in it.

Option 3: Move the cursor with the cursor key to the hyperlink.

You can now edit the text without activating the hyperlink.

Change the URL of a hyperlink as follows

Option 1: As described above, move the cursor to the hyperlink and
open Hyperlink Dialog (icon on the function toolbar).

Option 2: Open Hyperlink Toolbar (VIEW - ICON TOOLBAR - HYPER-
LINK TOOLBAR). Click on the hyperlink, do not release the mouse key
and drag the hyperlink to the hyperlink toolbar. The mouse pointer
points where you can drop the hyperlink. Edit the URL in the hyper-
link toolbar and press the ENTER key.
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Change the attribute of all hyperlinks as follows

Edit the color and formatting of hyperlinks in your document through
the ”Internet Link” und ”Visited Internet Link” character styles in the
Stylist.

Edit a hyperlink button as follows

If the hyperlink is a button, click on the border to select it, or press
the (Option)(Alt) key while clicking. Open the Properties dialog via
the context menu. You can edit the label text under ”Caption,” and
modify the address in the ”URL” field.

Switch off the automatic recognition of hyperlink as follows

Switch the automatic recognition of hyperlinks on and off through
TAGS - AUTOCORRECT/AUTOFORMAT - OPTIONS in the Recognize URL
check box.

4.8.5 Inserting a hyperlink

You can insert hyperlinks in two ways: as text or a button. In both
cases the visible text can be differentiated from a URL.

1. Let the hyperlink bar be displayed by calling up VIEW - ICON

TOOLBAR - HYPERLINK TOOLBAR. Enter the visible text in the
left field and the full URL in the right field, including http:// or
file://.

2. Place the text cursor in the document at the point where the hy-
perlink should be inserted. Click on the Link icon in the hyper-
link toolbar or on ACCEPT in the hyperlink dialog. The hyperlink
is inserted as text.

3. If you wish to insert the hyperlink as a button, press the mouse
key on the Link icon a little longer and select the As Button
command in the sub-menu or select the Button entry in the
hyperlink dialog beside Form.
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If you would rather use the Hyperlink Dialog instead of the hyperlink
toolbar to define the hyperlink, you can call it up using the icon in
the function toolbar.

If you wish to jump to a specific position in the same text document,
enter the bookmark at that position (INSERT - BOOKMARK). If you
wish to branch out to a cell in a table, enter a name for the cell
(INSERT - NAME - DEFINE).

In the Collection Box for Internet URLs combo box enter only the
short form of the URL when jumping within the same document: If
the bookmark is called Target, enter Target. To jump to another
document, enter the complete URL.

Hyperlinks can also be inserted through Drag & Drag from the navi-
gator. Hyperlinks can refer to references, headings, graphics, tables,
objects, directories or bookmarks.

If you wish to insert in a text a hyperlink that refers to Table 1, drag
the entry Table 1 from the navigator and drop it in the text. To do
this, the Insert as Hyperlink drag mode must be selected in the navi-
gator.

4.8.6 Searching with the hyperlink toolbar

The Search function in the Hyperlink bar is explained in detail in the
Help.

1. Enter the text you want to find in the URL Text field.

If you double-click on a word in a text, it is automatically en-
tered.

2. Click the Search icon to open a submenu.

3. Select your preferred search engine from the list.

SOT Office calls your Web Browser and the latter makes the connec-
tion to a search engine. After a short time you will see the result of
your search on screen.
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4.8.7 Drawing a graphic with the draw functions

Open Draw Functions on the main toolbar.

When you select a function, the relevant icon appears on the main
toolbar. Now you can restart this function by clicking on it briefly.
A longer click opens the floating toolbar from which you can select a
different function.

Drawing objects can be edited and modified subsequently. Drawing
elements created in this way are vector graphics which you can scale
freely without any loss of quality. Drag the floating toolbar on to the
screen as a separate window if you want to draw several elements.

Create a rectangle by clicking on the rectangle icon, then pointing in
the document at the place where you want one corner of the rectangle
to be. Press the mouse button there and hold it down wile dragging
to the opposite corner of the rectangle. When you release the mouse
button, the rectangle is inserted in the document. It is selected, and
you can edit its properties via the context menu.

If you want to open up drawing objects from the center instead of
dragging from one corner to the other, hold down the ALT key while
dragging. Holding down the SHIFT key while dragging limits the cre-
ated object. For example, instead of a rectangle with sides of different
length, you obtain a square.

To scale the objects, first select them by clicking on them with the
selection tool. You then see eight handles around the object. When
you drag one of the four corner handles, the opposite corner remains
fixed while the other three corners move. When you drag one of the
side handles, the opposite side remains fixed.

To move drawing objects, first select them (individually, or press
SHIFT to select several together). Select text objects by clicking ex-
actly on their edge. While holding down the mouse button, drag the
objects to the new location. If you hold down SHIFT while dragging,
the objects can only be positioned in places compatible with the page
margins and the other objects on the page.

Hold down the CTRL while dragging the drawing object to copy the
object.

To revert to normal text mode after creating and editing drawing ob-
jects, click in an area of the document containing no drawing or other
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objects. If you are in a drawing view, first exit this by clicking on the
Select icon, for example.

4.8.8 Selecting the document language

The language you choose for your document determines, amongst
other things, the dictionary to be used for spelling, thesaurus and
hyphenation, the decimal and thousands separator to be used and
the default currency format.

Basically, the language selected for the whole document applies.

Within the document, you can apply a separate language to any para-
graph style. This has priority over the language of the whole docu-
ment.

Within a paragraph, you can assign a language to selected pieces of
text, either by direct formatting or via a character style. This as-
signment then has priority over the paragraph style and document
language.

Selecting a language for the whole document

1. Choose TOOLS - OPTIONS. Go to LANGUAGE SETTINGS - LAN-
GUAGES.

2. Under Default languages for documents, select the document
language for all documents created from new. If you mark For
the current document only, your choice will only apply to the
current document. Close the dialog with OK.

Selecting a language for a paragraph style

1. Place the cursor in the paragraph whose paragraph style you
want to edit.

2. Open the context menu and select Edit Paragraph Style.... This
opens the Paragraph Style dialog.

3. Select the Font tab.

4. Select the Language and click on OK.
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Now, all paragraphs formatted with the current paragraph style will
have the selected language.

Applying a language directly to selected text

1. Select the text to which you want to apply a language.

2. Choose FORMAT - CHARACTER. This opens the Character dialog.

3. Select the Font tab.

4. Select the Language and click on OK.

In SOT Office Calc, choose FORMAT - CELLS and proceed accordingly.

Selecting a language for a character style

1. Open the Stylist and click on the Character Styles icon.

2. Click on the name of the character style to which you want to
apply a different language.

3. Then open the context menu in the Stylist and choose Modify.
This opens the Character Style dialog.

4. Select the Font tab.

5. Select the Language and click on OK.

Now you can apply the character style to your selected text.

4.8.9 Turning off numbering/bullets for individual para-
graphs

If the cursor is located in a numbering or bullet style then you can
switch the automatic numbering or listing in the current paragraph
or selected paragraphs off by clicking the Numbering Off icon in the
numbering object bar or the Bullets On/Off icon in the text object
bar.
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If the cursor is located within a section with numbering or bullets,
you can turn off automatic numbers or bullets for the current para-
graph or selected paragraphs by clicking the Number List On/Off
icon on the Object Bar.

To remove an existing paragraph from the numbering in a section of
bullets or numbering using the keyboard, do the following:

• Place the cursor at the beginning of a numbered paragraph and
press the BACKSPACE key.

The numbering before the paragraph disappears and is removed from
the numbering sequence. Numbering resumes in the following para-
graph.

If you press the ENTER key in an empty paragraph, the current num-
bering comes to an end.

4.8.10 Select maximum possible page format

Not all printers can print a paper up to its edges. Most of them leave
an unprinted margin. How far can you extend the text or graphics in
a document before they get cut off?

SOT Office offers a semi-automatic feature that enables you to print
as close to the paper’s edge as it is possible.

Make sure that your printer has been setup under FILE - PRINTER

Setup.

Make sure that the Online Layout in the View menu is not active.

Select the FORMAT - PAGE command, and go to the Page tab.

Under Margins you can define the maximum or minimum possible
value for the page margins (left, right, top, and bottom) by pressing
the PAGE UP or PAGE DOWN keys. The preview displays a dashed line
around the printable range.

Click OK to close the dialog.
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4.8.11 Printing in black and white

If you have a color printer but only wish to print in black and white,
you have the following options:

Printing text and graphics in black and white

1. Choose FILE - PRINT. This opens the Print dialog.

2. Click on Properties. This opens the properties dialog for your
printer.

3. Select the option to print in black and white. For further infor-
mation, refer to the help for your printer or read your printer
manual.

4. Confirm the Properties dialog and click on OK in the Print dialog.

The current document will be printed in black and white.

Printing in black and white in SOT Office Impress and SOT Office
Draw

1. Choose TOOLS - OPTIONS - PRESENTATION or TOOLS - OPTIONS

- DRAWING , as appropriate.

2. Then choose Print.

3. Under Quality select either Grayscale or Black & White and click
on OK.

From now on, all presentations or drawings will be printed without
color.

Selecting the Default quality option allows documents to be printed
in color again later on.

Grayscale converts everything to a maximum of 256 gradations from
black to white.

Black & White converts everything into the two values black and
white.
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Printing only text in black and white

In SOT Office Writer you can choose to print color-formatted text in
black and white. You can specify this either for all text documents to
be printed in the future, or only for a printing process of the current
text document.

Printing all text documents with black and white text

1. Choose TOOLS - OPTIONS - TEXT DOCUMENT or TOOLS - OPTIONS

- HTML DOCUMENT .

2. Then choose Print.

3. Under Contents mark Print black and click on OK.

All text documents or HTML documents will in future be printed with
black text.

Printing the current text document with black and white text

1. Choose FILE - PRINT. This opens the Print dialog.

2. Click the OPTIONS button. This opens the Printer Options dia-
log.

3. Under Contents mark Print black and click on OK.

4.8.12 Printing in another order

This is how you can print documents in the correct order.

Select the FILE - PRINT menu command and then the OPTIONS but-
ton. Select Reversed in the Pages area. Confirm with OK. The last
page is then first printed out and the first page last.

4.8.13 Creating round corners

When you insert a rectangle or a callout box using the drawing tools
and activate the function Edit Points, you see a small frame at the
upper left corner of the object. The frame indicates the amount by
which the corners are rounded. When the frame is positioned at the
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top left corner, no rounding occurs. When the frame is positioned
on the handle in the middle at the top of the object, the corners are
rounded as much as possible. You adjust the degree of rounding by
moving the frame between these two positions.

If you place the cursor on the box it changes to a hand symbol. You
can now drag the box to change the amount of rounding. An outline
shows a preview of the result as you go.

4.8.14 Sending a form fax

If you wish to send a form fax to several fax recipients, there are two
alternatives:

Either your fax driver allows the entry of several recipients for the
same document, or you wish to send a document with several indi-
vidual data to each recipient according to a form letter.

Additional information on form letters can be found in SOT Office
Help.

Note, however, that the fax driver must perform the individual assign-
ment of a document to a fax number. For this purpose, you normally
have to enter a sequence of control characters and the desired fax
number in the first line of the document; please consult the please
documentation of your fax software for help.

4.8.15 Inserting non-breaking spaces, dash, definite
separators

Non-breaking spaces

To prevent two words from being separated at the end of a line, press
the CTRL key when you type a space between the words. This is
important, for example, between a title and the person’s name.

Non-breaking dash

An example for a non-breaking dash would be company name A-Z.
In this case, you clearly do not wish that the A- is at the end of a line
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and the Z at the beginning of the next. Instead of a dash (-) enter a
similarly looking special character (INSERT - SPECIAL CHARACTER).

In Windows, the symbol #173 is suitable (press ALT and enter 0173
on the numeric keypad).

Definite separator

If you wish to support automatic hyphenation by entering a separator
inside a word yourself, use the CTRL key combination and the minus
character. The word is separated at the end of the line at this position
even if automatic hyphenation for this paragraph is switched off.

4.8.16 Versions and build numbers, developer lists

• Choose HELP - ABOUT SOT OFFICE. This opens a dialog con-
taining information.

• To obtain further information, hold down the CTRL key and
press the letters S D T in succession. At the beginning you
will find information about the version and build number. This
is followed by a list of developers. To stop the information before
the end, press the Input key (ESC).

4.8.17 Setting up Printer, Fax and Fonts under GNU/Linux

Under GNU/Linux, the printer administration program ”spadmin” is
provided to help you set up printers, faxes and fonts for use with SOT
Office.

Call the printer administration program ”spadmin” as follows:

• Go to the soto/program directory.

• Enter:

./spadmin
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• After it starts, the window of the printer administration program
”spadmin” appears. That is where you can make all important
settings.

• During a network installation, the System Administrator first
logs on as user root and calls the printer administration pro-
gram ”spadmin”. He or she then creates a general printer config-
uration file called soto/share/psprint/psprint.conf for all
users. All changes are immediately available to all users in SOT
Office.

The system administrator can also add fonts for all users in the
network installation. However, these fonts are available only after
restarting SOT Office.

Setting up Printers

Under GNU/Linux, SOT Office only offers direct support for PostScript
printers. Other printers must be set up as described in the section
Printer Drivers in SOT Office. SOT Office automatically provides a
printer with the default driver for each system queue. You can add
additional printers as needed.

Adding a Printer

1. Click the NEW PRINTER button.

2. Select the CREATE PRINTER option and click NEXT.

3. Select the appropriate driver for your printer. If you are not
using a PostScript printer or your model is not listed, use the
”Generic Printer” driver or follow the steps below. You can also
add new drivers using the Import button or delete unnecessary
drivers using the Delete button (see below for details). Click
NEXT.

4. Choose a command line that you can use to print on your printer
(for example, lp -d my queue ). Click NEXT.

5. Give the printer a name and determine whether it should be-
come the default printer. Click FINISH.
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6. To print a test page, click on TEST PAGE. If the test page fails to
print or is incorrectly printed, check all settings as described in
Change Printer Settings.

You now have a new printer in SOT Office.

Printer Drivers in SOT Office

When installing a non-PostScript enabled printer, you must set your
system so that PostScript can be converted into the language of the
printer. We recommend using current PostScript conversion software
such as Ghostscript (http://www.cs.wisc.edu/˜ ghost/).

If you are in possession of a PostScript-enabled printer, you must
always install a description file that adapts the printer (PostScript
Printer Definition - PPD) so that you can utilize the paper tray selec-
tion, the duplex print function (if the printer has it) and any built-in
fonts. You can also use the generic printer driver since it contains the
most important data and is suitable for most printers. In that case,
you will have to do without the paper tray selection and correctly set
the page margins.

Drivers can be imported or deleted when creating a new printer.

To import new drivers, click Import in the driver selection dialog.
Click BROWSE to select the directory where you unpacked the PPD
files. In the Selection of drivers list box, select the printer driver you
want to install and then click OK.

To delete a printer driver, select the printer driver and click DELETE.
Be sure that you do not delete the generic printer driver, and re-
member that drivers deleted from network installations are no longer
available to other users who are using the same network installation.

If the printer has more fonts built in than the usual PostScript fonts,
you must also load the AFM files for these additional fonts. Copy the
AFM files into the soto/share/psprint/fontmetric directory of the
SOT Office installation or into the soto/user/psprint/fontmetric
directory of the User Installation. You can find AFM files, for example,
at ftp://ftp.adobe.com/pub/adobe/type/win/all/afmfiles/.
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Changing Printer Settings

In the printer administration program ”spadmin”, select the printer
from the Installed printers list box and click PROPERTIES. The Prop-
erties dialog appears containing several tab pages. This is where you
can make settings that are used according to the PPD file of the se-
lected printer.

Select the command on the Command tab page. You can remove
superfluous commands using the REMOVE button.

On the Paper tab page, you can define the paper format and paper
tray to be used as the default settings for this printer.

On the Device tab page, you can activate the special options for your
printer. If your printer can only print in black and white, choose
”grayscale” under Color, otherwise choose ”color”. If switching to
grayscale leads to unfavorable results, you can also select ”color” un-
der Color and see how the printer or PostScript emulator applies it.
Furthermore, on this tab page you can set the precision with which
colors are described as well as the PostScript level.

The Font Replacement tab page allows you to select a printer font type
available in the printer for each font type installed on your computer.
This way you can reduce the data volume sent to the printer. Font
replacement can be turned on or off for each printer individually.

You should also set the page margins correctly on the Additional set-
tings tab when using the generic printer drivers so that your printout
is not cropped. You can also enter a description in the Comments
field, which will also be displayed on the Print dialog.

Some of these settings can also be set per document/printout in the
Print dialog or the Printer Settings dialog in SOT Office through the
Properties button.

Renaming or Deleting Printers

Select a printer from the Installed printers list box.

To rename the selected printer, click RENAME. Enter an appropriate
name in the dialog that appears and click OK. The name must be
unique and should be chosen so that you can recognize the printer
and the application. Printer names must be assigned the same for all
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users because, when documents are exchanged, the selected printer
remains unchanged if the recipient has it under the same name.

To delete the selected printer, click REMOVE. The default printer or
a printer that has been created by the system administrator in a
network installation cannot be removed using this dialog.

Selecting a Default Printer

To make the printer selected from the Installed printers list box the
default printer, double-click its name or click the Default button.

Using Fax Functionality

If you have already installed a fax package such as Efax or HylaFax
on your computer, you can send faxes with SOT Office.

1. Click New Printer. This opens the Add Printer dialog.

2. Select Connect a fax device. Click NEXT.

3. Choose whether to use the default driver or another printer
driver. Click NEXT. If you are not using the default driver, select
the appropriate driver and click NEXT.

4. Enter a command line with which to communicate with the fax
in the following dialog. In the command line of each fax sent
”(TMP)” is replaced by a temporary file and ”(PHONE)” by the
telephone number of the recipient fax machine. If ”(TMP)” occurs
in the command line, the PostScript code is transmitted in a file,
otherwise via standard input (i.e., as a pipe). Click NEXT.

5. Assign a name to your new fax printer and determine whether
the telephone numbers (see below) marked in the text should be
removed from the printout, or not. Click FINISH.

You can now send faxes by printing to the printer that has just been
created.

Enter the fax number as text in the document. You can also enter
a field that takes the fax number from your active database. In any
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case, the fax number must start with the characters @@# and end
with @@. A valid entry would have the form @@#1234567@@.

If these characters including the telephone number are not printed,
activate the Fax number is removed from the printout option under
Properties in the Command tab page. If no telephone number is en-
tered in the document, a dialog prompting you for it will appear after
the printout.

In SOT Office you can also activate a button for sending faxes to a
default fax. To do this, right-click the function bar, open the Visible
Buttons submenu and click the SEND DEFAULT FAX button. You can
set which fax is used when this button is pressed under TOOLS -
OPTIONS - TEXT DOCUMENT - PRINT.

Remember to create one separate print job for each fax. Otherwise,
the first recipient would receive all the faxes. In the FILE - FORM

LETTER dialog select the Printer option and then the Create Individual
Print Jobs field.

Connecting a PostScript for PDF Converter

If a PostScript for PDF converter such as Ghostscript or Adobe Acro-
bat Distiller(tm) is installed on your computer, you can quickly create
PDF documents in SOT Office. Under GNU/Linux, PDF printing via
Ghostscript is set up by default—simply choose PDF Printing from
the Print menu. To set up a different PDF converter follow the steps
below.

1. Click NEW PRINTER. This opens the Add Printer dialog.

2. Select Connect a PDF converter. Click NEXT.

3. Choose whether to use the default driver, the Acrobat Distiller
driver or another driver. Click Next. If you are not using the de-
fault driver or the Acrobat Distiller driver, select the appropriate
driver and click NEXT.

4. In the next dialog, enter a command line with which to com-
municate with the PostScript− >PDF Converter. Moreover, en-
ter the directory where the PDF files created should be saved.
If you do not provide this directory, the user’s home directory
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will be used. In the command line of each created PDF docu-
ment ”(TMP)” is replaced by a temporary file and ”(OUTFILE)” by
the target file, the name of which is created from the document
name. If ”(TMP)” occurs in the command line, the Postscript
code is transmitted in a file, otherwise via standard input (i.e.,
as a pipe). If Ghostscript or Adobe Acrobat Distiller is in the
search path, you can use one of the predefined command lines.
Click NEXT.

5. Assign a name to your new PDF converter. Click NEXT.

You can now create PDF documents by printing to the converter that
has just been created.

Installing Fonts

When you are working with SOT Office you might notice that a dif-
ferent number of fonts is provided depending on the document type
being used. This is because not all of the fonts can be used in every
case.

Therefore, only those fonts will be shown in the font selection box
when working with a text document which can also be printed, as it
is assumed that you will only want to use those fonts that you can
actually have printed on paper.

In an HTML document or in online layout, only fonts that are avail-
able on screen are offered to you.

On the other hand, when working with spreadsheets and drawings
you will be able to use all of the fonts that can be either printed or
shown on the screen.

SOT Office tries to have the display on screen correspond to the print-
out (WYSIWYG). Possible problems using the font are shown in the
bottom margin of the dialog you open by choosing Format - Charac-
ter.

Adding Fonts

You can integrate additional fonts in SOT Office. Fonts which you
integrate are available exclusively to SOT Office and can be used with
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various Xservers without your having to install them there. To make
the fonts available to other programs as well, proceed as usual by
adding the fonts to your Xserver. SOT Office can display and print out
PostScript Type1 fonts as well as TrueType fonts (including TrueType
Collections).

To integrate additional fonts in SOT Office, proceed as follows:

1. Start spadmin.

2. Click FONTS.

3. All fonts added for SOT Office are listed in the dialog that ap-
pears. You can remove selected fonts using the REMOVE button
or add new fonts with the ADD button.

4. Click ADD. The Add Fonts dialog appears.

5. Enter the directory from which you want to add the fonts. Press
the ... button and select the directory from the path selection
dialog or enter the directory directly.

6. Now a list of the fonts from this directory appears. Select the
fonts you want to add. To add all the fonts, click SELECT ALL.

7. With the Create soft links only check box you can determine
whether the fonts are to be copied into the SOT Office directory
or only symbolic links are to be created there. If the fonts to be
added are on a data medium that is not always available (such
as a CD-ROM), you must copy the fonts.

8. Click OK. The fonts will now be added.

In the case of a network installation, the fonts are installed in that
installation if possible. If the user has no write access rights, the
fonts will be installed in the user installation so that only the user
who installed them can access them.

Deleting Fonts

To delete fonts, proceed as follows:

1. Start spadmin.
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2. Click FONTS.

3. All fonts added to SOT Office are listed in the dialog that now
appears. Select the fonts you want to delete and click DELETE.

You can delete only the fonts that have been added for SOT Office.

Renaming Fonts

You can also rename fonts added for SOT Office. This is especially
useful for fonts that contain several localized names (such as an En-
glish and a Japanese name). There are also fonts that contain an
unreadable name. You can replace this with a suitable name.

1. Start spadmin.

2. Click FONTS.

3. Select the fonts you want to rename and click RENAME.

4. Enter a new name in the dialog that appears. If the font con-
tains several names, these names will serve as suggestions in
the combo box where you enter the new name.

5. Click OK.

If you select several fonts to rename, one dialog appears for each
selected font.

If you have selected a TrueType Collection (TTC), one dialog appears
for each of the fonts contained in it.
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5.1 What is a macro?

Macros help automate tasks, making work easier. As you become
more familiar with SOT Office, you may find yourself performing the
same group of actions over and over. Using a macro, you can combine
all these actions into a single process so that a complicated sequence
becomes as simple as the click of a button.

A macro is actually a program, written in the SOT Office Basic lan-
guage. In this chapter, you’ll learn how to import macros into SOT
Office Basic and how to use them in your everyday work.

A set of related macros are stored together in a module. Related
modules are grouped together in libraries. Libraries can be stored
as part of SOT Office, so you can use them with any and all of your
documents, or they can be saved as part of a specific document or
template.

General SOT Office users should read sections 5.2 and 5.3 below
for information about using the macros supplied with SOT Office.
Advanced users who are familiar with BASIC and object-oriented
programming may also wish to read section 5.4 for information
about writing custom macros in SOT Office.

5.2 Using macros

5.2.1 How to run a macro

To apply a macro to your work, access it using the TOOLS>MACRO

menu. If the macro operates on a selection (selected text), you’ll
need to select that text using the mouse and/or keyboard (see Sec-
tion 3.2.2). For example, to use the ConvertSelected macro, which
converts all selected numbers (given in digits) into their word-equivalents,
enter a few numbers in a blank text document and select them with
the cursor. If you choose to select more than one item, you’ll need to
use hold down the CTRL key while making each selection after the
first.

From the menu bar, select TOOLS>MACRO and double-click the SAM-
PLE library. The library will open, displaying a number of modules.
Click on the NUM2TEXT module and select the (ConvertSelected) from
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Figure 5.1: Testing the ConvertSelected macro

the left-hand panel. To execute the selected macro, click on button
marked RUN.

Figure 5.2: Running the ConvertSelected macro

The macro will be executed, converting your selected numbers into
text:

Figure 5.3: Result of running ConvertSelected
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5.2.2 Assigning a macro to a toolbar button

If you use a macro frequently you may find it useful to add it as a
button to one of the SOT Office toolbars. You can then activate the
macro simply by clicking on its button. To add a macro to a toolbar,
do the following:

• Right-click on any SOT Office toolbar, and choose CUSTOMIZE

from the context menu that appears.

• A ‘customize toolbars’ window will appear. At the bottom of this
window are two panels, used to select the function you wish to
add to the toolbar.

Figure 5.4: Assigning a macro to a toolbar button

Scroll down the Category panel until you come to the SOT OF-
FICE BASIC MACROS category. Click on the small + sign to open
this category and select the library and module containing your
macro.

• The names of the macros contained in the selected module will
appear at the top of the window. These are actually buttons—
click on the one you want and drag it onto a toolbar.

• If you wish to associate an icon with the macro (instead of a text
button), click on the BUTTONS... button and select an icon for
your macro.
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• Click CLOSE to finish. Your chosen macro now appears as a
button on the toolbar.

5.2.3 Assigning a macro to a key combination

If you prefer using the keyboard over the mouse you may wish to
assign a macro to a key combination. This way you can run a macro
in just a couple of keystrokes. Perform the following steps to assign
a macro to a key combination:

• From the menu bar choose TOOLS>CONFIGURE. A configuration
window will appear. Click on the KEYBOARD tab of this window.

Figure 5.5: Assigning a macro to a key combination

• Scroll down the Category panel until you come to the SOT OF-
FICE BASIC MACROS category. Click on the small + sign to open
this category and select the library and module containing your
macro.

• A list of shortcut keys and key combinations is listed at the top
of the window. Find and select an unused key combination and
click the MODIFY button to assign the chosen macro.

• Click OK. Your macro can now be run by pressing the chosen
key combination.
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5.2.4 Assigning a macro to a menu

You can also create new menu entries to run macros. To add your
macro to a SOT Office menu, do the following:

• From the menu bar choose TOOLS>CONFIGURE. A configuration
window will appear. Click on the MENU tab of this window.

Figure 5.6: Assigning a macro to menu

• Scroll down the Category panel until you come to the SOT OF-
FICE BASIC MACROS category. Click on the small + sign to open
this category and select the library and module containing your
macro.

• A list of menu and submenu entries is shown at the top of the
window. Click on the name of the menu in which you want to
place you macro entry and click the NEW button. The name
of your macro will appear under the chosen menu. You can
reposition menu entries by selecting the entry you want to move
and clicking the large up and down arrows in the configuration
window.

• When the menus are arranged to your liking click OK. Your
macro will now appear as an entry in the chosen menu.
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5.3 Built-in macros

SOT Office comes with a number of macros built-in. You’ll find the
following modules in your SOT Office installation under the SAMPLE

library—experiment with them to see if they can be of use to you.

CompareSheets Summarizes the differences between the cells of two
worksheets.

DocumentStatistics Counts the number of words and characters in
a document or selection.

DrawChartFromSheetData Creates a bar chart in SOT Office Calc
from the selected data.

DrawingExample Opens an SOT Office Draw document and creates
colored polygons. Use this as an example of how to create your
own drawing macros.

Num2Text This contains ConvertSelected associated macros, that
replace a numeric string with its text-equivalent.

PrintSheettoWriterDocument Copies the selected cells (in SOT Of-
fice Calc) and creates a table from them in a SOT Office Writer
document.

RemoveCharacters Deletes extra spaces and tabs from a document.

SaveAsDate Saves a spreadsheet with a name corresponding to the
current date, e.g. ‘16 Jul 2002.sxc’.

TransposeCharacters Swaps the positions of the two characters ei-
ther side of the cursor.

TransposeSpreadsheet Exchanges the values of rows and columns
in a spreadsheet.

5.4 How to create a macro

5.4.1 Making a library

The first thing to decide when creating your own macros, is where
you’re going to keep them. We suggest saving them in your own
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custom library, so they won’t get mixed up with the existing SOT
Office macros.

To create a new library to hold your macros, run SOT Office and do
the following:

• From the menu bar, select TOOLS>MACRO. This will open the
macro dialog box.

Figure 5.7: The macro dialog box

• Click on the Libraries tab and select the NEW button

• Enter the name of your new library, for example “CoolMacros” and
click OK.

• You can then close the Organizer (hit the CLOSE button).

• You are now back at the macro dialog box. Hit CLOSE once more
to return to the document screen.

You’ve now successfully added a new SOT Office library to hold your
macros.
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5.4.2 Writing your first macro

• From the menu bar, select TOOLS>MACRO. This will open the
macro dialog box.

• You should see your new library present in the list headed Macro
from. An empty module named Module1 is already present in
your library. Click on Module1 and then on the EDIT button.

• A new window will appear. This is the Basic IDE (Integrated
Development Environment). The Basic IDE is where you’ll write,
edit and save your macros.

To learn more about the IDE, read ”How to use the editor”, below. Or
you can skip ahead to ”Entering your macro commands”.

5.4.3 How to use the Editor

The basic IDE consists of the following features:

Editor window

This is where you’ll enter the Basic program instructions that make
up your macro.

Macro toolbar

The macro toolbar gives you quick access to the following useful func-
tions:

The library box lets you navigate among the
various SOT Office libraries.

Run macro. Begins executing the first macro in the selected
library. You can use this to test your macros.

Stop macro. Stops execution of a macro-in-progress.
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Figure 5.8: The editor window

Figure 5.9: The macro toolbar

Procedure step, single step, step out. These functions
are used to execute the macro step by step. Procedure step runs
the macro one procedure at time, Single step takes it one com-
mand at a time. Step Out takes execution one step backwards.

Breakpoint and add watch. These are useful for debugging
macro code. Inserting a breakpoint in a program will stop the
macro running as soon as the breakpoint is reached. By click-
ing on a variable in the Basic code and clicking the Add Watch
button you can observe how the value of the variable changes
as the program is run.
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Object catalog, macros and modules. The object catalog
button opens a window showing all the macros present in SOT
Office. The macros button opens the macros dialog (figure 5.7).
The modules button opens the organizer, letting you rearrange
your macros.

Find parenthesis. Used to select all the text between a pair of
open and closing paraentheses.

Dialog Controls open a toolbar letting you create dialog boxes
to use with your macros.

Insert source text and save source as let you import pre-
written macros, or save your own as a text file so you can use
them in other Basic applications. Macro source files end in a
.bas extension.

5.4.4 Entering your macro commands

Macros are written in the object-oriented Basic programming lan-
guage. Enter the text of your macro into the editor’s window.

Once the entire text is entered, close the IDE window. The macro is
now saved.
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A.1 Shortcut keys

Shortcut Action
ENTER Activate the selected button in a dialog box
ESC Cancel an action or dialog
SPACEBAR Toggle the selected button in a dialog box

CTRL+A Select all
CTRL+B Bold text
CTRL+C Copy the selected area
CTRL+F Find and Replace
CTRL+I Italic text
CTRL+N Begin a new document
CTRL+O Open a document
CTRL+P Print current document
CTRL+Q Close SOT Office
CTRL+S Save current document
CTRL+U Underlined text
CTRL+V Paste from the clipboard
CTRL+X Cut out the selected area
CTRL+Z Undo

Function
Keys
F1 Help
F3 Find again
Shift+F3 Find backwards
Ctrl+F4 Close current task

Figure A.1: Keyboard shortcuts in SOT Office
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3D objects, 36

alignment, 17
area properties, 36
arrows

drawing, 34
autocorrect, 40
automatic fill, 27
AVERAGE function, 26

background, 82
slides, 31

bold, 17
bullets, 89

cells, 23
formatting, 26
ranges, 24

chart, 28, 76, 79, 80
charts

legend, 80
title, 79

circle pie
drawing, 33

circles
drawing, 33

color, 18
text, 74

configuration, 66
configure, 65, 66
contents

table of, 21

CONVERT function, 26
copy, 17, 54–56
curves

drawing, 34
cut, 17

database
export, 57

deleting text, 17
documents, 16

structure, 18
drag and drop, 49
drawing objects, 87
drawing view, 29

edit points, 36
ellipses

drawing, 33
export database, 57

fax, 67, 94
form fax, 93

fill, 27
font, 17
fonts, 94
footer, 20
Format menu, 18
formatting, 17

graphics, 36
formula bar, 24
formulas, 24
function bar, 15
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functions, 25

gallery, 51, 52
graphics, 32

copying, 54
drawing, 87
filling, 36
formatting, 36
on slides, 31
shadow, 36

handout view, 30
header, 20
headings, 19
help, 46
hyperlinks, 42, 86

editing, 84
inserting, 85

IDE, 111
indexes

creating, 22
insert mode, 74
italic, 17

key combo
assigning macro to, 107

language, 88
library, 109
lines, 34, 36

arrows, 36
drawing, 34
editing properties, 36

macro
assigning to key combo, 107
assigning to menu, 108
assigning to toolbar, 106

macros, 104
built-in, 109

editing, 111
MAX function, 26
measurement units, 69
menu

assigning macro to, 108
menu bar, 14
Microsoft format, 42
moving graphic objects, 35

navigation, 48, 82
navigation toolbar, 47
notes view, 30
numbering, 89
numbering pages, 20

object bar, 15
open documents, 41
opening files

URL field, 45
outline view, 29
overwrite mode, 74

page
numbering, 20

page style, 19
paragraph

style, 18
paste, 17, 56
presentations, 28
printer, 94
printing, 90–92

rectangles
drawing, 33

rotating objects, 35
rotation

creating 3D objects, 37
rounded corners, 92

save documents, 42
saving documents, 15
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searching text, 57
segments

drawing, 33
set up, 82
shadow, 36
slide show, 30, 32
slides

adding graphics, 31
adding more, 32
adding text, 31

slides view, 30
SOT Draw, 32
SOT Office, 14

starting, 14
SOT Office Calc, 23
SOT Office Impress, 28
SOT Office Writer, 16
spaces

non-breaking, 93
special characters, 56
spellcheck, 23
spelling, 23
spreadsheet

automatic fill, 27
cells, 23
chart, 28
formulas, 24
functions, 25

spreadsheets
creating, 23

structured documents, 18
style, 18
Stylist, 18, 21
SUM function, 26

tab stops, 72
table of contents, 21
tables

copying, 52
templates, 40, 70

text
color, 18
copying, 17
cutting, 17
deleting, 17
editing in Writer, 16
formatting, 17
in drawings, 35
justify, 17
pasting, 17
selecting, 16
slides, 31

title, 41
TODAY function, 26
toolbar

assigning macro to, 106
floating, 47
form functions, 57
hyperlink, 86
icons, 68, 71
object, 72

toolbars, 15
customizing, 46

underline, 17
URL field, 44

version, 94
version management, 60–62, 64

merging, 62
protecting, 64

views
presentation, 29
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Feedback

SOT welcomes your comments about SOT Office! By completing and
returning this form you’ll help us to make SOT Office even better.
Send the completed form to :

SOT Oy Suomen Ohjelmistoty Ab
Salomonkatu 17A
00100 HELSINKI

Optional

Your name:

Your email address: @

Additional comments:


